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Technology Licenses

The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in accor-
dance with the terms of such license.

U.S. Government Rights

The Software is "commercial computer soft-
ware," as defined by Federal Acquisition
Regulation ("FAR") 2.101. Pursuant to FAR
12.212 and 27.405-3 and Department of
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Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating proce-
dure, practice, or the like that, if not
correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

A WARNING notice denotes a hazard.
It calls attention to an operating pro-
cedure, practice, or the like that, if not
correctly performed or adhered to,
could result in personal injury or
death. Do not proceed beyond a
WARNING notice until the indicated
conditions are fully understood and
met.
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Safety Summary

General
Before Applying
Power

Ground the
Instrument

Fuses

Do Not Operate in
an Explosive
Atmosphere

Do Not Remove the
Instrument Cover

Cleaning

Do Not Modify the
Instrument

In Case of Damage

The following general safety precautions must be observed during all phases of operation of this
instrument. Failure to comply with these precautions or with specific warnings or operating
instructions in the product manuals violates safety standards of design, manufacture, and intended
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply
with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in
printed form. Printed manuals are an option for many products. Manuals may also be available on
the Web. Go to www.keysight.com and type in your product number in the Search field at the top of
the page.

Do not use this product in any manner not specified by the manufacturer. The protective features of
this product may be impaired if it is used in @ manner not specified in the operation instructions.

Verify that all safety precautions are taken. Make all connections to the unit before applying power.
Note the instrument's external markings described in “Safety Symbols”.

If your product is provided with a grounding type power plug, the instrument chassis and cover must
be connected to an electrical ground to minimize shock hazard. The ground pin must be firmly
connected to an electrical ground (safety ground) terminal at the power outlet. Any interruption of
the protective (grounding) conductor or disconnection of the protective earth terminal will cause a
potential shock hazard that could result in personal injury.

See the user's guide or operator's manual for information about line-fuse replacement. Some
instruments contain an internal fuse, which is not user accessible.

Do not operate the instrument in the presence of flammable gases or fumes.

Only qualified, service-trained personnel who are aware of the hazards involved should remove
instrument covers. Always disconnect the power cable and any external circuits before removing the
instrument cover.

Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use
detergent or chemical solvents.

Do not install substitute parts or perform any unauthorized modification to the product. Return the
product to a Keysight Sales and Service Office for service and repair to ensure that safety features
are maintained.

Instruments that appear damaged or defective should be made inoperative and secured against
unintended operation until they can be repaired by qualified service personnel.

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice,
or the like that, if not correctly performed or adhered to, could result in damage to the
product or loss of important data. Do not proceed beyond a CAUTION notice until the
indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure,
practice, or the like that, if not correctly performed or adhered to, could result in
personal injury or death. Do not proceed beyond a WARNING notice until the indicated
conditions are fully understood and met.
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Safety Symbols

Table 1 Safety Symbol

Description

(%]
<
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=3

Direct current

Alternating current

Both direct and alternating current

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

Neutral conductor on permanently
installed equipment

Line conductor on permanently installed
equipment

On (mains supply)

Off (mains supply)

Standby (mains supply). The instrument is
not completely disconnected from the
mains supply when the power switch is in
the standby position

In position of a bi-stable push switch

Out position of a bi-stable push switch
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Symbol Description

Equipment protected throughout by
DOUBLE INSULATION or REINFORCED
INSULATION

Caution, refer to accompanying
documentation

Caution, risk of electric shock

Do not apply around or remove from
HAZARDOUS LIVE conductors

Application around and removal from
HAZARDOUS LIVE conductors is
permitted

Caution, hot surface

lonizing radiation

CpEEH@P B

IEC Measurement Category |

Measurement Category |I
CATIII Measurement Category lIl
CAT IV Measurement Category IV
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Compliance and Environmental Information

Table 2 Compliance and Environmental Information
Safety Symbol Description
CSA is the Canadian certification mark to demonstrate compliance with the Safety
S © requirements.

The C-tick mark is a registered trademark of the Spectrum Management Agency of
Australia. This signifies compliance with the Australia EMC Framework regulations
under the terms of the Radio Communication Act of 1992.

CE compliance marking to the EU Safety and EMC Directives.
ISM GRP-1A classification according to the international EMC standard.
ICES/NMB-001 compliance marking to the Canadian EMC standard.

3 b

Table 3 Environmental Information

Safety Symbols Description

This product complies with the WEEE Directive (2002/96/EC) marking requirements.
The affixed label indicates that you must not discard this electrical/electronic

product in domestic household waste.

Product Category: With reference to the requirement types in the WEEE Directive
Annex |, this product is classed as a “Monitoring and Control Instrumentation”
product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
www.keysight.com/environment/product/ for more information.
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Introduction

The U4421A MIPI D-PHY Analyzer and Exerciser module lets you:

capture and decode MIPI D-PHY data and view it in a Protocol Viewer or a Waveform Viewer
window.

send D-PHY stimulus to a D-PHY component by emulating a master D-PHY component.
The U4421A module supports link widths from x1 to x4.

This module needs to be installed in a Keysight AXle chassis (for example, the M9502A 2 slot
chassis).

When a controller PC is connected to the AXle chassis via an external PCle interface and cable, the
Keysight Logic and Protocol Analyzer application (running on the controller PC) lets you configure,
control, and use the U4421A module for stimulus/analysis functions.

This guide describes how to use the U4421A module for stimulus and analysis, once the hardware
and software components are installed.



1 Introduction

Features

The U4421A module can act as an Exerciser to transmit D-PHY stimulus to a DUT or an Analyzer to
acquire D-PHY protocol and signal level data from DUT or both Exerciser and Analyzer.

As an Exerciser

Can transmit in HS and LP modes.
Maximum data rate is 1.5 Gbps in HS mode transmission.

Provides an integrated application called Image to quickly generate CSV files from images in the
CSI/DSI packet format.

Allows you to transmit a set of CSV files in a specified sequence. A CSV file transmission can be
repeated for a user-defined number of times.

As an Analyzer

Can acquire protocol level data as well as raw signal level data.
Allows you to allocate memory separately for protocol level and raw signal level data acquisition.

Allows you to adjust timing parameters or use the default timing parameters set as per the D-PHY
specifications.

Provides a number of viewers to view the acquired data.

Allows cross-triggering with an external oscilloscope and making time-correlated measurements
(using markers). You can display data captured by the oscilloscope in the Waveform and Listing
display windows. This external oscilloscope correlation and data display feature is also referred to
as View Scope. To know more about this feature and how to use it with the U4421A Analyzer, refer
to the External Oscilloscope Time Correlation and Data Display Online Help.
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Introduction 1

Usage Scenarios

This topic describes some usage scenarios of the U4421A module. For a specific usage scenario, you
need to:

obtain an appropriate license for the desired functionality.
set up the probing configurations as per the usage scenario.
select an appropriate Mode in the Connection Setup tab of the Setup dialog box.

Providing Stimulus to a DUT

In this scenario, U4421A can emulate a master D-PHY component and exercise and stimulate the
DUT with various customized D-PHY control and data packets.

By emulating a D-PHY link partner, the module lets you test the DUT independently.

You need an Exerciser license for the U4421A module for this usage scenario.

Providing and Monitoring Stimulus

In this usage scenario, you can use the U4421A module to:
stimulate the connected DUT by transmitting D-PHY signals to the DUT.

monitor the stimulus output sent from the U4421A module to the DUT. To accomplish this, you do
not need any external analysis probes. An internal loopback connection is used to monitor the
stimulus output. In this mode, the U4421A module acquires only protocol level data. The Raw
mode capture is not available in this mode.

You need an Exerciser license for the U4421A module for this usage scenario.

Acquiring D-PHY Data

In this usage scenario, you can use the U4421A module as an analyzer to passively probe and
acquire data from the DUT. In this mode, U4421A can acquire both protocol level and raw signal
level data simultaneously.

You need an Analyzer license for the U4421A module to use this connection mode.

Providing Stimulus and Acquiring D-PHY Data

Both the exerciser and analyzer capabilities of the U4421A module are available. In this usage
scenario, you can:

either acquire data and provide stimulus to the same DUT
or connect the U4421A module to two different DUTs for acquiring data and providing stimulus.

You need an Analyzer and Exerciser license for the U4421A module for this usage scenario.

Keysight U4421A MIPI D-PHY Analyzer and Exerciser User Guide 13
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Related Documents

Besides using this U4421A online help, you can also access the following documents that provide
related information about the U4421A module.

MIPI D-PHY Protocol Analyzer and Exerciser Hardware and Probing Guide - This guide provides information
on the stimulus and acquisition probing options available for use with the U4421A module. This
guide is available on www.keysight.com/find/dphy_analyzer and is also installed with the Logic
and Protocol Analyzer software at <logic Analyzer Install location>\help\pdfs. It describes how to
make probing connections from the DUT to the Keysight U4421A module for various probing
situations.

AXle Based Logic Analysis and Pratocol Test Modules Installation Guide - This guide provides information
on the Keysight AXle chassis, the U44271A module, how to set up the chassis, module, and host
computer and how to obtain and install the associated software components. This guide is
available on www.keysight.com/find/dphy_analyzer and is also installed with the Logic and
Protocol Analyzer software at <logic Analyzer Install location>\help\pdfs.

MIPI D-PHY Protocol Analyzer and Exerciser User Guide - The PDF version of the contents of this online
help. This user guide describes how to configure and use the U4421A module to provide stimulus
and capture D-PHY data. It also describes the usage of the set of APIs that allow you to control,
manage, and use the U4421A module programmatically. This guide is available on
www.keysight.com/find/dphy_analyzer and is also installed with the Logic and Protocol Analyzer
software at <logic Analyzer Install location>\help\pdfs.

Context-sensitive help - A context-sensitive HTML help page is available with each window and
dialog box of the U4421A module on clicking the Help button displayed within the GUI element.

Training and Tutorials - You can find training and tutorials PDF for the U4421A module in the
Document Library tab on www.keysight.com/find/dphy_analyzer.
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2 Configuring U4421A
Connection Settings

Once you have connected the U4421A module, probing hardware, and DUT in the required
configuration based on the module’s usage scenario, the next step is to configure the module’s
connection setup in the Keysight Logic and Protocol Analyzer application. You use the Connection
Setup tab of the U4421A module’s Setup dialog to configure its connection setup.

Connaction Setup | Analyzer Sstup | Exerciser Electrical I Exerciser Timing | Exerciser Data | Packet Insertion

- Module
| d‘lassisl SIDI Salect Pr{:rtucdl Mode I Linkis) | Typa | l
@ 1 2 MIPI-DSI IE'-:ern:iser and Ar.al':j D5I-102  U4421 MipiDphy DSI &nalyzer MipiDphy 4C

— Link Naming and Lane Setup

Name | State Activity | Input Data Rate | probe
= All MIPL-DSI Links
[ DSI-102
DI-102 o000 O Unable to detect SoftTouch
Rename Add Folder Delete F:-Iu:lerl

# LED Caolor Legend

—Chock —Lane
@ sToP state with LRt ® izrc is in the STOP state with LP11 () Escape mod
@ sTOP state with LE00 @ lane is in the STOP state with LPOO £ Escape mod
() Lane is receiving HS data. () lane has moved to LPOO via a HS request @ Hot Availabl
O Escape mode, BTA, ULPM regusst. @ Linz is between HS sync and HE exit. Recsiving HS data
KEYSIGHT

TECHNOLOGIES



2 Configuring U4421A Connection Settings

You specify the connection details on the basis of the stimulus/analysis functions that you want the
U4421A module to perform. The connection setup details that you specify in this tab tells the Logic
and Protocol Analyzer software how the U4421A module is connected to the DUT in terms such as
the connection mode, probing option used and the link width needed. For instance, if you have
connected the U4421A module hardware to the DUT only to capture data on all four D-PHY data
lanes, then you need to select the Analyzer only as the connection mode and x4 as the link width in
the Connection Setup tab to reflect the configured hardware setup.

To configure U4421A connection setup

1

In the Logic and Protocol Analyzer GUI, access the Setup dialog box of the U4421A module by
clicking Setup > Setup from the GUI's menubar.

The Connection Setup tab is displayed in the Setup dialog box.
Configure connection settings in this tab. The tab has the following fields.

Field Description

Module - This group box displays read-only and editable fields for the U4421A module hardware.

Chassis

Read-only field that displays the AXle chassis number in which you installed the U4421A hardware module.

Slot

Read-only field that displays the slot number of the AXIe chassis in which you installed the U4421A hardware module.

Select Protocol

Displays the protocol family that you selected at the time of starting up the Logic and Protocol Analyzer GUI session.

Mode

U4421A has four connection modes to ensure that an appropriate connection is configured based on the specific usage
scenario. These modes are:
= Analyzer Only - In this mode, the U4421A module can only be used as an analyzer to passively probe and acquire data
from the DUT. This mode doesn’t allow the usage of the U4421A module as an Exerciser to stimulate the DUT. In this
mode, U4421A can acquire both protocol level and raw signal level data simultaneously.
You need an Analyzer license of the U4421A module to use this connection mode.
= Exerciser Only - In this mode, the U4421A module can only be used to stimulate the connected DUT by emulating the
master D-PHY component. This mode doesn’t allow the usage of the U4421A module as an analyzer to acquire D-PHY
data from the DUT.
You need an Exerciser license of the U4421A module to use this connection mode.
= Exerciser plus Monitor - In this mode, you can use the U4421A module to:
stimulate the connected DUT by transmitting D-PHY signals to DUT.
monitor the stimulus output sent from the U4421A module to the DUT. To accomplish this, you do not need any
external analysis probes. An internal loopback connection is used to monitor the output. In this mode, the U4421A
module acquires only protocol level data. Raw mode capture is not available in this mode.
You need an Exerciser license of the U4421A module to use this connection mode.
= Exerciser and Analyzer - In this mode, both the exerciser and analyzer capabilities of the U4421A module are available.
This mode allows you to either acquire data and provide stimulus to the same DUT or connect the U4421A module to
two different DUTs for acquiring data and providing stimulus. When using the U4421A module to provide stimulus and
acquire data from two different DUTs, ensure that the same protocol and link width is used for both stimulus as well as
analysis functions. However, you may adjust the input and output levels separately for the analysis and stimulus
functions.
You need an Analyzer and Exerciser license of the U4421A module to use this connection mode.

Link

Displays U4421A module type and number.

License

Displays the type of U4421A license(s) installed on the system.

Help

Provides the Connection diagram... button. Clicking this button displays the hardware connection diagram depicting the
hardware configuration as per the currently selected connection mode and link width settings.

Link Width

Select the link width for the D-PHY link you want to probe in the selected mode. Some of the options in the Link Width
listbox are disabled if you do not have the appropriate link width license installed.

Link Naming and Lane Setup

Name

Name of the D-PHY link.
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Configuring U4421A Connection Settings

2

Field Description

State Activity Displays the current status of the four data lanes and one clock lane LEDs located on the front panel of the U4421A module.
The following color coding is used for these LEDs to indicate the state activity on the associated lanes.
= Red - This means that the lane is in the STOP state with LP11.
= Blinking Red - This means that the lane is in the STOP state with LPOO. This lane status usually indicates:
LP lines are not probed
ultra-low power mode
= Green - This means that the lane has moved to LPOO via a HS request and it is waiting for the sync pattern. This lane
status occurs when something is wrong, for instance, incorrect probing setup or the lane not receiving correct HS data.
= Blinking Green - This means that the line is between HS sync and HS exit. and the lane is receiving HS data.
= Yellow - This means that the lane is in the Escape mode and data is being transmitted from master to slave. Escape
mode includes bus turn around (BTA), escape mode data transmission, and ULPM request.
= Blinking Yellow - This means that the lane is in the Escape mode and data is being transmitted from slave to master.
Escape mode includes bus turn around (BTA), escape mode data transmission, and ULPM request.
= Off - This means that the lane is not configured/available. Based on the link width that you select in the U4421
Connection Setup tab of the Logic Analyzer GUI, the number of lanes on the U4421A module are used. The LEDs of only
the used lanes glow. For example, if you are using the x2 link width, then the LEDs of only two lanes being used will
glow and the rest of the LEDs will be off.
You can also refer to the LED Color Legend section at the bottom of the tab to know what each LED color represents.
Input Data Rate Detects and displays the current input data rate of the U4421A module hardware. This value is updated automatically.
Probe(s) Type Detects and displays the probing option that you have used in the U4421A hardware setup to probe the DUT.

Probing options

The following three probing options are available for use with the U4421A module:

For providing stimulus

= U4422A SMA stimulus probe

For capturing D-PHY data

= E5405A Differential Soft Touch probe

= E5381A Differential Flying Lead probe

For detailed information on probes that you can use with U4421A, refer to the U4421A MIPI D-PHY Analyzer and Exerciser
Hardware and Probing Guide. The guide is available on www.keysight.com/find/dphy_analyzer and also installed
with the Keysight Logic and Protocol Analyzer software.

Lane Ordering

The Lane Ordering option lets you perform the ordering of the physical probe channels of the U4421A module with the
logical data lanes probed by each of these channels. You can either retain the Default lane ordering which means channel 0
of the module maps to logical lane 0 and so on. If you want to change this default mapping of channels with logical lanes,
then select the Custom option from Lane Ordering and click Specify to display the Custom Lane Ordering dialog box. In this
dialog box, select the module’s channel with which you want to map a target logical lane.

You can also set the polarity inversion property for each data lane using the Custom Lane Ordering dialog box. The polarity
of a data lane is not inverted when the positive and negative sides of the probe channel’s differential pair are connected to
the positive and negative sides of the signal in the DUT.

HCustnr‘n Lane Ordering @

Lane Reordering

Invert
Target Lane 0 maps to Analyzer Channel

Target Lane 1 maps to Analyzer Channel

ok | | Hep |

LED Color Legend

This section displays a description for the various colors of the clock and data lanes LEDs on the front panel of the U4421A
module. Each LED color represents a specific state activity on the associated lane. Refer to the State Activity field to know
more about the state activity on lanes.
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Selecting CSI or DSI Protocol

If you have a single (CSI or DSI) protocol license for the U4421A module, then by default, the Logic
and Protocol Analyzer GUI is started using that licensed protocol option when you launch this GUI.

If you have purchased both CSl and DSI protocol licenses for the U4421A module, then the Logic and
Protocol Analyzer GUI is started using the currently selected protocol option. In situations when both
CSl and DSl protocol licenses are available, you can choose the protocol license option with which
you want to launch the Logic and Protocol Analyzer GUI. This feature allows you to switch between
the CSI and DSl analysis when using the U4421A module with these multiple protocol license
options.

You use the U4421A-U4431A-Protocol-Selector.bat script to select CSI or DSI protocol when accessing
the Logic and Protocol Analyzer GUI.

The U4421A-U4431A-Protocol-Selector.bat script puts any active Logic and Protocol
Analyzer GUI sessions to the offline mode during protocol change. Therefore, you must stop
any ongoing analysis work and save your captured data/configurations before you start using
this script.

To select D-Phy protocols (CSI or DSI)

1 Double-click the U4421A-U4431A-Protocol-Selector.bat script to launch it. The script is installed at
the following location when you install the Keysight Logic and Protocol Analyzer software
(version 5.80.0000 or later).

C:\Program Files (x86)\Keysight Technologies\Logic Analyzer\Contributed Files (for 64 bit OS
installs)

or

C:\Program Files\Keysight Technologies\Logic Analyzer\Contributed Files (for 32 bit OS installs)

2 The script starts running in the Command window with warning messages displayed. Press any
key to continue.

'@ Protocol Selection T LB X,

This wutilitv switches bhetween licensed MIPI protocols wvhen an
Keysight D-PHY or M-PHY Protocol Analyzer module iz installed.

Any active Logic Analyzer application instance may bhe taken
OFFLIME during protocol selection. Stop all analwsis
activities and save any reqguired data or configurations now.

Once protocol selection completes the analyzer must he bhrought
hack online manuwally from inside the Logic and Protocol Analyzer
application interface: File »*> Go online To Local Host.

Press any key to continue . . .
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3 Selecting CSl or DSI Protocol

3 Specify the slot number in which you installed the U4421A module for which you want to select
the protocol. Press <Enter>.

5‘,@! Protocol Selection Too

IThis utility switches between licensed MIPI protocols when an
|Keysight D-PHY or M-PHY Protocol finalyzer module iz installed.

Any active Logic Analyzer application instance may be taken
OFFLIME during protocol selection. Stop all analysis
activities and save any required data or configurations now.

Once protocol selection completes the analuy=er must be brought
hack online manuwally from inside the Logic and Protocol Analuzer
application interface: File » Go online To Local Host.

Only protocols that are currently licensed for the module in
the zelected z=lot can be successfully enabled.

Enter 3lot number of the Protocol Analyzer module [1-51:

4 Specify the MIPI protocol that you want to select for the U4421A module. Specify D-PHY DS/ to
select the DSI protocol and D-PHY CSI to select the CSI protocol. Press <Enter>.

L BR Protocol Selection Too IE@_

lOnce protocol selection completes the analyzer must he hrowught
lhack online manually from inside the Logic and Protocol Analyzer
lapplication interface: File > Go online To Local Host.

Only protocols that are currently licensed for the module in
the selected slot can be successfully enabled.

£lot number of the Protocol Analyzer module [1-51: 3

Protocols:

M-PHY Unipro
M-PHY Unipro
M-PHY Unipro
M-FPHY S5IC

M-PHY M-PCle
D-PHY CS5I

D-PHY DSI

Select the MIFI Protocol to enabhle [1-71:
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Selecting CSl or DSI Protocol 3

The M-PHY options are available for the U4431A MIPI M-PHY module and are ignored for the
U4421A module.

5 The User Account Control dialog box is displayed. Click Yes to proceed.

e User Account Contral (=23

Do you want to allow the following program to make

changes to this computer?

"3 Program name:  agHwlpdate

e Verified publisher: Keysight Technologies, Incorporated
File crigin: Hard drive on this computer
“ | Show details Yes | | Mo

Change when these notifications appear

The script runs to perform the protocol change as per your selections. The protocol change is
successfully completed if you have specified the correct slot number for the U4421A module and
appropriate license is available for the selected protocol.

If an invalid option is entered (other than the number 1 to 7), the script fails to execute and keeps
on prompting until a valid choice is made.

@ Protocol Selection Tool

Protocols:

M-PHY
M-PHY
M-PHY
M-PHY
M-PHY
D-PHY

Unipro

Unipro

Unipro

S8IC

M-FPCle

CS1

D51

MIPI Protocol to enahle [1-71: d

Invalid choice: Please select a menu item from 1-7

Protocols:

M-PHY
M-PHY
M-PHY
M-PHY
M-PHY
D-PHY

Unipro

Unipro

Unipro

S8IC

M-FPCle

CS1

D51

MIPI Protocol to enahle [1-71:
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Selecting CSl or DSI Protocol

6 When the protocol change completes, you need to bring any open offline sessions of the Logic
and Protocol Analyzer GUI to the Online mode by clicking File > Go online to Local Host option in the

GUI's menubar. If there are no existing open sessions of the GUI, launch the GUI in the Online
mode.

The Logic and Protocol Analyzer GUI should now launch with the selected protocol.

To verify if protocol change is successful
Using the agNotificationCenter icon
1 Double-click the agNotificationCenter icon displayed in Window's taskbar.

2 In the Instrument Details dialog box, expand the U4421A module option for which you changed
the protocol.

The protocol currently selected for the module is displayed.

Instrument Details

. E}EQ MOS02A Logic/Protocal Tesk Syskem
----- B FRun State: Stopped

i) Frame Details

- Module: U44214 DPHY-DSI Prokocol Analvzer
- Module: U44214 DPHY-CSI Prokocol Analyzer
i Mumber of Cards: 1

fow St 1

= Slot-Specific and Licensed Features

[ Showe In-Lse Info ] [ Refresh ] [Start e La Offline ]

Using the Logic and Protocol Analyzer GUI
1 Launch the Logic and Protocol Analyzer GUI in the Online mode.

2 Click Setup > Setup from the GUI's menubar to access the Setup dialog box of the U4421A
module for which you changed the protocol.

3 In the Connection Setup tab, the currently selected protocol (CSI or DSI) for the module is
displayed.

Connection Setup |.-’-‘n.na|3,-zer Setup | Exerciser Electrical | Exerciser Timing | Exerciser Data | Packet Insel

Module
Chassis Slot Select Protocol Mode Link(s) Type
® 1 1 [mrpl-csi-2 | [Analyzer Only v] CSI-101  U4421 MipiDphy CSI Analyzer
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This chapter provides information on how to use the U4421A module to provide stimulus to a D-PHY
target. It describes how to configure the module for stimulus settings, how to create a stimulus file,
and how to start/stop the stimulus transmission.
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Providing Stimulus to a D-PHY Component

Before you Start

24

Before you start configuring the settings needed for sending stimulus to DUT, ensure that the
following tasks are performed.

You have connected the U4421A module to the DUT using the U4422A SMA stimulus probe in the
required configurations.

You have the licenses required for the stimulus function of the U4421A module.
You have installed the Keysight Logic and Protocol Analyzer GUI, version 5.50.0000 or higher.

You have configured the U4421A module’s connection setup in the Keysight Logic and Protocol
Analyzer GUI. Ensure that you select either Exerciser only or Exerciser and Analyzer as the
Connection mode in this GUI.

Transmit Memory Depth available to Exerciser

The Exerciser and Analyzer functions of the U4421A module share the total memory depth available
on the installed license of the U4421A module. For the Analyzer function, you allocate Raw Data
Capture and Protocol Data Capture memory depth in the Analyzer Setup tab. After these two
memory allocations, the memory remaining from the total available memory is allocated
automatically to the Exerciser function. However, if you are using only the Exerciser function of the
U4421A module, then the entire memory depth available on the installed license is allocated to the
Exerciser function.

You can view the memory available to the Exerciser function of the module in the Run Sequence
section of the Exerciser Data tab of the Setup dialog box.
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Providing Stimulus to a D-PHY Component 4

Adjusting Output and Voltage Settings for Stimulus

You use the Exerciser Electrical tab in the U4421A module’s setup dialog box to adjust output and
voltage settings for the module.

The fields in the Exerciser Electrical tab are enabled only when you select either
Exerciser only or Exerciser and Analyzer connection mode in the Connection
Setup tab.

Connaction Setup | Analyzer Sstup Exerciser Electrical | Exercizer Timing | Exercizer Data | Packet Insertion

- Jutput Contral
Target VDD I 1000 Vl Al mV [800-3300] [T Ignore Target VDD Safety Check
SMA Outputs I on "’I [Turn On anly after all voltages set]
Slew Rate I Fast "I

- Jutput Signal Levels

Target Termination Typa I Crynamic Differential 100 Ohms (D-Phy Standard) j

L? High I 1200 | A my [500-1300] LP High Min IW mi

LP Low I 0 v|a] mV [-100-100] LP Low Max [ mv

HS Vod I 200 ¥ Al v [60-320] HsHigh [so0 | ™V

HS Comman Mode I 200 ¥| Al v [60-380] Hslow  [1op | ™V Defaultlevels

1]

apply | ok |  cancel
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4 Providing Stimulus to a D-PHY Component

To configure U4421A output voltage and stimulus signal level settings

1 Inthe Logic and Protocol Analyzer GUI, access the Setup dialog box of the U4421A module by
clicking Setup > Setup from the GUI’s menubar.

The Connection Setup tab is displayed in the Setup dialog box by default.
Click the Exerciser Electrical tab.
Configure voltage and signal level settings in this tab. The tab has the following fields.

Field Description

Output Control

Target VDD Set the threshold voltage for the Vsen (Voltage Sense) signal. The DUT sends the Vsen signal to the U4421A module on
connecting the SMA stimulus cable for the Vsen signal to the DUT’s power supply, The Vsen signal indicates when the
module can actively send D- Phy signals to the DUT.

The U4421A module sends D-PHY signals to the DUT if the Vsen signal is above the set threshold voltage setting divided
by two. If the Vsen signal is below the set threshold voltage setting divided by two, the module will tri-state all the D-Phy
signals.

Ignore Target VDD Safety Check Select this checkbox to ignore the threshold voltage setting for the Vsen signal specified in the Target VDD field.
Selecting this checkbox is not recommended unless the target does not provide the Vsen signal.

SMA Outputs Set the SMA Outputs to On or Off to enable or disable the SMA stimulus outputs from the U4421A module to DUT.

Set the output voltage levels of U4421A correctly in this tab before enabling the SMA outputs for U4421A. If the output
voltage level is configured at a level too high for your board, your board may be damaged.

It is recommended to keep the SMA Outputs to OFF while changing voltage settings to protect your circuit from any
damage.

Slew Rate The Slew Rate setting changes the slew rate (and therefore the rise time) of the output signal driven from the U4421A
module.
In most situations, you may keep the Slew Rate at the Fast setting. Slower settings will help reduce Electro Magnetic
radiation and allow checking the DUT receiver's response to slower rise time input signals.
Typical rise times for HS mode signals driven into a 50 Ohm load are:

Fast - 170ps

Medium - 180ps

Slow - 200 ps

Slowest -350 ps
The signal integrity of the connection between the U4421A module and DUT receiver as well as the amount of input
capacitance at the receiver input will affect the actual rise time that the receiver will see. The Slowest setting should not be
used if the HS data rate is greater than 1Gbps.
The rise times of the signals when in LP mode is highly dependent on the total length and total capacitance of the
connection between the U4421A module and DUT. Typically, the LP rise and fall times are less than 5ns even at the Slowest
setting of Slew Rate.

Output Signal Levels - This section provides fields to adjust the voltage settings for low power and high speed modes. Set the voltage levels which should be present
at the receiver. The U4421A module calculates the output voltages which are necessary to achieve those voltages.

Target Termination Type Select the termination scheme used on the target board. The U4421A module supports the MIPI D-PHY standard for
terminating the differential outputs (a 100 ohm resistor between the signals). It also supports static differential 100 Ohms
as well as Open circuits as termination types.

Based on the target termination type you select, you must calculate the correct output voltages settings in the fields
described below.

The MIPI D-PHY standard calls for 80-ohm to 125-ohm HS line termination at the receiver. In LP mode, the termination is
“switched out” to make an un-terminated, single-ended receiver.

LP High Select the output level for LP High termination.
LP Low Select the output level for LP Low termination.
LP High Min Auto-calculated on the basis of the voltage levels that you selected in the LP High and LP Low fields.
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Field Description

LP Low Max Auto-calculated on the basis of the voltage levels that you selected in the LP High and LP Low fields.

HS High Auto-calculated on the basis of the voltage levels that you selected in the HS Vod and HS Common Mode fields.

HS Low Auto-calculated on the basis of the voltage levels that you selected in the HS Vod and HS Common Mode fields.

Default Levels Clicking this button resets the output voltage setting fields in the Output Signal Levels group box to their default values.

Double-check the output voltage settings by using an external resistor connected to the
U4421A stimulus outputs and verify that the Vhigh and Vlow values are correct.

If you enter wrong values for the output voltage settings, or if you think there is a termination
resistor there but it isn't actually installed, you can drive voltages that can harm your device.
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4 Providing Stimulus to a D-PHY Component

Adjusting U4421A Stimulus Signal Timings

You use the Exerciser Timing tab in the U4421A module’s setup dialog box to adjust these timings for
the module.

NOTE The fields in the Exerciser Timing tab are enabled only when you select either

Exerciser only or Exerciser and Analyzer connection mode in the Connection
Setup tab.

Connaction Setup | Analyzer Sstup | Exerciser Electrical Exerciser Timing | Exercizer Deta | Packest Insertion |

CS1-102 | - Clock Source

CS101) @ nternal I?sn vI Mbps UI Period :
1.33 ns
' External I 73 lel Mbps

- Timing Parameters Dehultsl
[Spec valuss]

HS-EXIT: I 100 j:l ns =[100 | rs [Min=100ns] CLK-PREP: I 38 j:l ns=[40
HS-TRAIL: I 80 j:l ns -[e0 | ns [Min=60ns] CLK-TRAIL: I &0 j:l ns=[e0
LPX: I 50 j:l ns =[50 | ns [Min=50ns] CLK-ZERO: I 205 j:l ne= 205
CLK-PRE: I 32 j:l UL+  20ns -[65  ns [Min=guT] Ta-GET: I 250 j:l ne= 250
CLK-POST: 80 j:l ns + I 52 j:l ur=[130  ns [Min=60ns+52ur]  TA-GO: I 200 j:l ne= [200
HS-PREP: I 40 j:l ns + I 3 j:l Ur=[45  ns [40ns+4Ul- 85ns+6UT] INIT: I 100000 j:l ns = [100000
hszere: [ 2] ns+ I 88 j:l ur=[120  ns [Min=60ns + 4ur] WAKEUP: I 1000000 j:l ns = [100000

- Lane Skaw Control

-GE7 o] 657
|t t } f t t l } f t t f b
h 4
oo | | | | | [ o]
- Pause Control
D1 | | | | | I 0 w|a| ps While running, pauss and insert
v voltage and skew changes at:
2 | | | | | | 0 v|af es | any stop state
h 4
o | I oA

| Walid Eye Spec = 400 ps |
; 1UI=1334ps {
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The Exerciser Timing tab has the following fields that you can modify to adjust the timings.

4

Field Description

Clock Source - Select either External or Internal reference clock source for the U4421A module. Based on the type of clock source you select, the default values of
some of the timing parameters and the adjusting range of the Lane Skew Control in this tab changes.

Internal

Select the Clock Source as Internal if you want the U4421A module to use the internal reference clock, selectable as either
750 Mbps or 1500 Mbps.

External

Select the Clock Source as External if you want the U4421A module to use an external reference clock.

Reference clock frequency - 1/10 the bit rate for bit rates < = 700mbps and 1/20 the bit rate for rates > 700mbps

NOTE: Make sure that you connect the Refp and Refn coaxial cables of the stimulus probe to accept the external reference
clock input signals. Refer to the U4421A MIPI D-PHY Analyzer and Exerciser - Hardware and Probing guide for instructions
on supplying an external reference clock to the U4421A module.

Measure

Clicking the Measure button displays the Measured Input Clock frequency when an External clock is selected.

Timing Parameters

The U4421A module, by default transmits stimulus signals with timings that comply with the MIPI D-PHY specifications.
The parameters that control these timings are displayed in the Timing Parameters section with their default values
auto-calculated according to the MIPI D-PHY specifications.

You may want to adjust these default stimulus signal timings to test how the DUT responds to an input timing that doesn’t
comply with the specifications or to accommodate a DUT that has timing requirements that do not comply with the
standards. In such situations, you can edit the values of timing parameters.

Timing adjustments are made with multiples of 5 ns resolution. The value you enter will be rounded down to the value
permitted by the resolution.

Clicking the Defaults button displayed in this section reverts the values of all timing parameters back to the default values
for the selected frequency.

NOTE:

When you change the bit rate in the Clock Source field, you MUST click the Defaults button to let the software calculate
default values for the changed bit rate. The default values for Timing Parameters are not autocalculated with the changes
you make to the Clock Source field.

Lane Skew Control

independently.

You can control the lane-to-lane skew by adjusting the range on each data lane independently. You can specify a skew relative to the output clock for each data lane

The limits and resolution of the adjustment range are displayed for each data lane.
You can adjust the lane skew dynamically as well during an ongoing stimulus flow.

Pause Control

The Pause Control section allows you to select the point at which you want the dynamically adjusted lane skew settings to

be implemented during an ongoing stimulus flow.

When you adjust the lane skew settings at runtime, the U4421A module halts the main stimulus flow at the selected Pause

Control point, implements the adjusted lane skew settings, and then resumes the main stimulus flow from the point at

which it was halted.

The Pause Control section provides the following two options:

= Any Stop State - Inserts the dynamically adjusted lane skew settings at the next stop state during an ongoing stimulus
flow.

= Only where insert bit is set - Inserts the dynamically adjusted lane skew settings at the next insertion point during an
ongoing stimulus flow. If you select this option, you need to define insertion point(s) in the stimulus CSV file. You can
define an insertion point by setting the Special bit to 1 in the CSV file. To know more about the Special bit and how to
define an insertion point in a CSV file, refer to the topic “Structure of a CSV Stimulus File" on page 34.

NOTE:

If, while adding the stimulus files to the run sequence, you select the Ignore Insert Bit checkbox in the Exerciser Data tab,

then the dynamic adjustment of the lane skew settings at the points where Insert bits are defined is disabled.

After you have configured the stimulus settings, you may save these settings in a Logic Analyzer
configuration (.ala) file to be able to recall these in the future. To do this, click File > Save, select a

location and name for the configuration file, select Standard Configuration (.ala) from the Save as type

listbox and then click Save.
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Creating Stimulus Files

30

Overview

In the Exerciser mode, the U4421A module can transmit both HS and LP data as stimulus, with 1.5
Gbps as the maximum bit rate for the HS transmissions. In this mode, it can only act as a master
D-PHY component and send transmission in the Forward direction. (Sending stimulus in the Reverse
direction is not supported.)

The task of generating D-PHY stimulus generally involves creating control data and payload packets
that the U4421A module can send as stimulus in a user-specified sequence to the DUT. You must
provide this control and payload data in CSV formatted files.
You can create CSV files in one of the following ways.

From Images (bitmap files) with specified parameters (Using the Image Inserter application)

By manually creating CSV files.

You can also send packets dynamically at runtime to DUT using the Packet Insertion feature of the
U4421A module.

The topics that follow describe these ways of creating a stimulus CSV file.

Using the Image Inserter Application

You can use the Image Inserter application to quickly build stimulus from bitmap files. This
application is integrated with the Keysight Logic and Protocol Analyzer GUI. You can invoke it from
this GUI if you have the appropriate U4421A software license.

The Image Inserter application supports the complete set of image formats defined in the CSI-2 and
DSl specifications. In this application, you can load one or more images and specify the translation
properties. The application converts the loaded images into a CSV file with image data in the CSI/DSI
packet format. This CSV file can then be used as is or modified, to be used as stimulus.

You can save the output of the Image Inserter application in a new or an existing CSV file and then
load this file in the Exerciser Data tab to send it as stimulus.

The Image Inserter application supports both CSI and DSl packet formats. When you invoke this
application from a DSI setup, it supports burst mode, non-burst mode, command mode and
initialization commands. It generates CSV files in three different formats depending on the mode you
selected.

To know how to test Video mode for a display module, refer to the topic “Generating DSI Stimulus
for Video Mode Testing of a Display Module" on page 47.

To create a CSV stimulus file from bitmap files

1 Launch the Setup dialog box of the U4421A module in the Keysight Logic and Protocol Analyzer
GUL

Click the Exerciser Data tab.
3 Click the New File button.
The Image Inserter application is displayed.

Keysight U4421A MIPI D-PHY Analyzer and Exerciser User Guide



== DSIImage Inserter

Burst Mode | Mon-Burst Mede | Command Mode |

Providing Stimulus to a D-PHY Component

Link Width HS Bit Rate (Mbps)

@x1 Ox2 O3 O E|E|

| Link width and H5 Bit Rate can be configured in Setup dig
Pixel Stream Mode

[Pacl:.ed Pixel Stream, 24-bit RGB, &-8-8 Format

L3 [(WACT lines) Horizontal Active Pixel Con
100 100

L1 (VSA lines) L2 (VEP lines)

L4 (WFP lines) Clock enable time before |

2 v

T1: Line time (ns)

100

Virtual Channel
3306.67 0
Cutput frame count

o ]

Compression

L3: VACT
Lines

L4: VFP

Lings LP-11 or Blanking Packet

c1
Next Frame - VSS: Sync Event, V-Sync Start

. HSS: Sync Event, H-Sync Start

: C1,C2,C3 : Byte Count

Calculatad from Bit Rate (Mbs)

mage Selection

File Path Height  Width

[ Enable | Settings |
BLLP-1 LA

C1 (Byte Count) Time (ns)
Blanking | 300 3264
BLLP-2 + HFB

C2 (Byte Count) Time . Add ] [ Remaove ] [ Move Up ] [ Move Down ] [ Clear ]

4 m | 3 <« | 1 | ,
Cutput File: l Browse l | Create File | [ Lead ] l Save l [ Close ] l Help l

4

4 Specify the image translation parameters in the left pane.
a Select an appropriate tab on the left that matches the required image transfer mode.

Burst mode - This mode is used to send data asynchronously so that the bus can either be
shut down or shared with another device. It also allows low-resolution video (such as view
finders) to be sent in LP data mode.

Non-Burst mode - This mode is used to send data in real-time. Synchronization can be
achieved with sync pulses or synchronization events.

Command mode - This mode uses industry defined display commands to define how data
is sent and interpreted. DSI has a 64k maximum word count. Therefore, these images
must usually be broken into multiple packets.

Keysight U4421A MIPI D-PHY Analyzer and Exerciser User Guide

31



4

32
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The Burst Mode and Non-Burst Mode tabs display read-only fields for Link Width and HS Bit

Rate (Mbps). In these read-only fields, the values that you set for Link Width in the Connection
Setup tab and Clock Source in the Exerciser Timing tab are displayed. If you want to change

these read-only values, you can do so in the Connection Setup and Exerciser Timing tabs.

b Some packet parameters are automatically calculated in the left pane. If required, change
these parameters. In Non-Burst mode, parameters are calculated in terms of Pixel Clock
Cycles, and are dependent upon the Pixel Stream Format.

A diagrammatic representation of these parameters is displayed in the right pane. The changes
that you make to these parameters’ values are reflected automatically in this diagrammatic
representation.

DSI packet formats allow you to compress the image.

To set up the image compression settings,

a Select the Enable checkbox from the Compression section.

Compression

The Compression section is visible only for the DSI packet formats. For other packet formats
such as CSI protocols, the Compression section is not visible.

The Enable button is enabled only if a compatible packed pixel stream is selected from the Pixel
Stream Mode listbox. For example, if you have selected the option Packet Pixel Stream, 18-bit
RGB, 6-6-6 Format from Pixel Stream Mode listbox, the Enable button is disabled.

b To view the image compression settings, click Settings.
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The DSI Image Compression Settings application is displayed.

E DSIImage Compression Settings

Compression Settings

[C] Muxing Made On [C1ICH Enable
PPS
Convert RGB Enable 422 Block Prediction Enable VBR Enal
PPSId 0|w|a| Bits Per Component 8 Compression [E] Bits Per Pixe
Picture Width 100 |»|a|  Picture Height 100 v~
Slice Width 100 |w|a|  Slice Height 100 [w|a|  Slices Per line 1 Herizontal s
Line Buffer Depth (bits) g [wlal  Chunk Size 100 |v|~|  Initial Xmit Delay 512 [w|a|  Initial Dec D
Initial Scale Value 32 vl Scale Increment Interval 808 [w|~| Scale Decrement Interval 1 [w]
Initial Offset f144 |»|~|  Final Offset 4096 |w|~| Flatness Min QP 3 |w|a|  Flatness Ma:
First Line Bpg Offset 12 [v|~| MFL Bpg Cffset 249 |w|a|  Slice Bpg Offset 1234 [w| A
RC Parameters
Maodel Size 8192 [v|~| Edge Factor 6 [w|a| Quant Incr Limit O 11 [w|a] QuantIncr Li
Target Offzet Hi 3|w|a| Target Offzet Lo 3 (v
Buffer Thresh 14,2842,56,70,84,08,105,112,119,121,123,125,126 14 values rar
Range Min QP 00113333335557.13 15 values rar
Range Max QP 4456777891011,12131315 15 values rar
Range Bpg Offset 2,00,-2,-4,-6,-8-8-8-10,-10,-12,-12-12 -12 15 values rar
Export PES | | ImportPPs | | oK

¢ To save the current picture parameter set to XML format, click Export PPS. To import a
predefined picture parameter set, click Import PPS.

d To save the current settings and return to image inserter application, click OK.
You have now set up the image compression settings.

6 Click Add from the Image Selection section to add one or more bitmap files from which the CSV file
has to be created.

The images that you add to the Image Selection section must have the same dimensions. If you
add images of different dimensions, an error message is displayed and the CSV file is not
created.

7 Repeat steps 4 and 6 for the different modes in which you want to create CSV file from bitmap
files. The parameters relevant for each mode are grouped in various tabs displayed in the left
pane.

8 In the Output File field, specify or browse to the name and complete path of the CSV file that you
want to generate from the selected bitmap files.

9 Click Create File.
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The CSV file is created at the specified location.

Creating/Editing a CSV Stimulus File Manually

You can either create a new CSV file manually or edit an existing CSV file (initially created using
Image Inserter) to customize it as per your specific stimulus requirements.

While creating/editing a CSV file, you need to ensure that the structure of the file is as per the
structure described below.

Structure of a CSV Stimulus File

Most of the rows in a CSV stimulus file correspond to packets to be sent as stimulus to DUT and
contain specific fields in a specific sequence for a packet. Some of the rows, however, are also
dedicated to setting bits of certain fields such as the Special field. Such rows do not correspond to
packets.

The following screen displays a sample CSV file with the fields and their sequence highlighted in the
25" row. Field values in the 271" row have been used to set the Special field to 1. Field values for
packets are specified from 28th row onwards.

M/ HBP Time: Z05.000000000000000 ns
x5 InsTimE, LES8, Escape, ULPC, Special, ©lock, Data |

5 /4 Btart Image Frame 1

»7  poooooooood, o, o, O, 1, 1 Corresponds to Special field
5 oooooooooo, 1, 1, O, O, 1, 78 7] settod.

¢%  oooooQoooa, 1, o, o, O, 1, 01, 00, OO0, oo

!0 000DO01Z804, 1, O, 0O, O, 1, 21, 00, 00, o0 |Corespond to packets

il O00o00onZss0%, 1, 1, O, O, 1, 21, 00, 00, OO

{2  0DOOD38414, 1, 1, 0, O, 1, 05 _

i3 fFf-- Frame = 1, Line = 1

i1  0DODOS1Z18, 1, 1, 0O, 0O, 1, 21, DO, DO, OO

i5 0o0ooosid4es, 1, 0O, 0O, O, 1, 3=, 80, 04, oo, 78, 73, 56, 72, T4, 57,

The following table describes each of these fields of a CSV stimulus file.
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Field Description

nsTime

The time at which the packet should be sent as stimulus. This packet timing is useful when you want to time the Start of Packet (SoP) of one packet to the

SoP of another packet. The packet timing is based on the following calculations:

= If the time difference between nsTime (n+1) is greater than nsTime (n), time is considered to be absolute. (n represents packet number)

= If the time difference between nsTime (n+1) is less than nsTime (), time is considered to be relative to the previous packet. This is done to allow the
concatenation of different frames or user-created / Image Inserter created CSV files, without having to recalculate time stamps.

Here are some examples of the packet timing calculations.

Packet nsTime Absolute Time Wait Time Motes

numkber At Beginning of Packet
1 0000020000 | 20,000 ns 20,000 ns | First Line in the CSV.

Previous time is considered

to be zero.

2 0000020000 20,000 ns + however 0 ns nsTime are equal. No wait

long Packet 1 took time between packets

3 0000040000 | 40,000 ns 20,000 ns | nsTime{3) >nsTime(2).

4 0000010000| 50,000 ns 10,000 ns |nsTime({d) <nsTime(3). Can be to

mark concatenation point of

anotherCsV file. The wait time

will bereferencedion.

Absolute time does notreset.

5 0000030000 | 70,000 ns 20,000 ns | Delayed another 20us relative to
the previous packet, butthe
absolute time reference continue,
Two multi-line CSV files now
combined.

The time between packets can sometimes be different from the time stated by the nsTime field due to the following causes:

= If the first packet takes longer to send than the wait time, then the second packet will be sent as soon as possible after the first packet.

= Housekeeping operations related to, but not explicitly calculated in the CSV line. nsTime indicates the time at which the module should start
sending the packet, that is, the time the module starts an HS or an LPDT request. The time from when the module starts the request to the time the
first byte of the packet is sent can vary in some cases. For example, an HS packet is to be sent but the clock is not on. In this case, the module must
start the clock before the HS burst can start. Therefore, the time from when the module starts to the time when the first byte is sent will include
starting the clock.

LPS

The LPS field can accept either of the following two values:

= 1-Indicates that the low-power state should be entered and the packet should begin with a new HS/LP frame. If the line does not have data, the link
will return to the Stop state. If the line has data, the link will return to the Stop state before sending the packet.

= 0 - Indicates that the packet should continue in the same HS/LP frame as the previous packet.

Escape

The Escape field can accept either of the following two values:

= 1 -Indicates that the packet should be transmitted using the Escape mode.
If only one data byte is valid and it is a valid escape entry code (except LPDT), then the U4421A module will do an escape mode request followed
by the entry code.
If there is more than one data byte, then the U4421A module assumes that the data should be sent using LPDT. In this case, the CSV must not
include 0x87 before the packet data. The U4421A module interprets it as packet data and inserts 0x87, where required.
If the LPS and Escape bits are set and there is only 1 valid data byte and that data byte is OxFF, then the U4421A module interprets it as a Bus
Turnaround (BTA) request.

= 0 - Indicates that the packet should be transmitted using High-Speed Data Transmission (HSDT).
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Field Description

ULPC The ULPC field can accept either of the following two values:

= 1 - Indicates entry of the clock to ultra-low power mode. ULPC only puts the clock into ultra-low power mode. If you want to set this field's value to
1, ensure that you dedicate a line in the CSV file for this purpose. The line then does not correspond to a packet. If you set this bit along with other
packet data, ULPC will be executed the next time the bus reaches an LP state.

= 0 - Do not enter ultra-low power mode.

Placing data lanes into the ULP mode

1. Set the Escape bit to 1.

2. Specify "78" as the Data Value in the same line.
Example:
0000010000, 1,1,0,0,0,78

Placing both data lanes and clock into the ULP mode

To place both data lane and clock into the ULP mode, first place the clock into the ULP mode followed by the data lane.
Example:
0000010000,1,1,1,0,0,78
//wait Tms and then send a packet which will pull the clock and data lane out of ULPS
0001010000, 1,0, 0,0, 1,01, 00, 00, 00

NOTE: To place the clock into the ULPS mode, you must put the data lanes into ULPS or send Escape data. The clock cannot be put into ULPS by itself.
Example to put clock lanes into ULPS and send escape data:
0000010000, 1,1, 1,0, 0, 21, 00, 00, 00

Special The Special field is used to set the insertion point for a: ) ) ]
. tgnamiq packet insertion and transmission during an ongoing stimulus flow. Refer to the topic “Inserti ng Packets Dynam|cally (nan
ngoing Stimulus Flow" on page 44 to know more. o

= implementation of dynamic adjustment of lane skew settings during an ongoing stimulus flow. Refer to the topic “Adj usti ng U4421A
Stimulus Signal Timings” on page 28 to know more.

This field can accept either of the following two values:

= 1 -Indicates an insertion point for a packet to be inserted and sent dynamically during the ongoing stimulus flow. At this point, the main stimulus
flow is halted, the user-defined dynamic packet is sent, and the stimulus flow is resumed.
If you want to set this field's value to 1, ensure that you dedicate a line in the CSV file for this purpose and also set the LPS bit to 1. The line then does
not correspond to a packet. If you set this bit along with other packet data, DPI will be executed the next time the bus reaches an LP state. Following
is an example of a line in a CSV file with the Special bit set separately in the line.
nsTime  LPS Escape  ULPC Special  Clock Data
/[ Setthe special hit for packet insertion

0 1 0 0 0

= 0 - Indicates that a dynamic packet/dynamic lane skew adjustment cannot be inserted at this point in transmission.

NOTE: To avoid voltage glitches, you should ensure that the clock is not running when the dynamic lane skew change is executed. To do this, remove the

Clock bit, then set the Special bit in the next line for the dynamic lane skew change, and finally reset the Clock bit later.

Clock The Clock field is used to set the HS clock. It can accept either of the following two values:

= 1 - Indicates that the HS clock is enabled.

= 0 - Indicates that the HS clock is disabled.

You must set this bit in each line of the CSV file for continuous clocking.

For image traffic, requiring many frames and blanking periods, this can be accomplished more efficiently by defining the blanking period as "LP11" or

"LP11 without clock" using the Image Inserter application.
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Field Description

Data The value for the Data field starts from the seventh column in the CSV file. This value spans across multiple columns in the CSV file representing various
parameters required in the data stream for a particular packet. The first parameter in the Data field is the packet type followed by the parameters required
for that packet type. The parameters, therefore, vary with the type of packet that you want to send as stimulus.

Typically, the following set of parameters are applicable for the Data field.
VCI, Packet Type, WC, ECC, Data, CRC
Parameter Description Number of bits
VI Virtual Channel Indicator 2 bits
Packet Type The type of data being sent | 6 hits
WC Word Count 2 bytes
ilong packets only)
ECC Error Correction Code 1 byte
Data Packet Payload 0, 1 or 2 bytes for short packets
(long packets only) WC bytes for long packets
CRC Cyclic Redundancy Check 2 bytes
Note: If you specify the value of ECC and CRC parameters as 00, then the ECC and Checksum are calculated automatically when you add the CSV file to
the stimulus run sequence. If you specify a value other than 00, then the specified value is used instead.
Example: Consider the following value in the Data field:
39,03, 00, 00, 37, 33, 44, 00, 00
In this value, 39 indicates that the packet type to be sent is DCS Long Write. For this packet type, the rest of the provided parameters indicate:
0 - Virtual channel 0
03 - MSB of Word Count =03
00 - LSB of Word Count = 00
00 - ECC to be generated automatically
37 - DCS Command = set_scroll_start
33 - set_scroll_start parameter byte 0
44- set_scroll_start parameter byte 1
00 - CRC MSB automatically generated when both the MSB and LSB CRC bytes are 00
00 - CRC LSB automatically generated when both the MSB and LSB CRC bytes are 00
Refer to the table Packet types and their Packet Payload Parameters to getalist of packet types and a description of the
parameters required in the Data field for different packet types.
Packet Types and Packet Payload Parameters
The following table lists various packet types that you can include in a CSV stimulus file and the
payload parameters that you need to specify in the Data field for each of these packet types.
Table 4 Packet types and their Packet Payload Parameters

Packet Type (hex) Description of the packet type Packet Payload Parameters

DSI HS Short Packets

01 Sync Event, V Sync Start 01, VCI, Short Packet Data 0, Short Packet Data 1

" Sync Event, V Sync End 11, VCI, Short Packet Data 0, Short Packet Data 1

21 Sync Event, H Sync Start 21, VCI, Short Packet Data 0, Short Packet Data 1

31 Sync Event, H Sync End 31, VCI, Short Packet Data 0, Short Packet Data 1

08 End of Transmission packet (EoTp) 08, 00 (VCI), FF (SPDO), FF (SPD1)

02 Color Mode (CM) Off Command 02, VCI, Short Packet Data 0, Short Packet Data 1

12 Color Mode (CM) On Command 12, VCI, Short Packet Data 0, Short Packet Data 1
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Packet Type (hex) Description of the packet type Packet Payload Parameters

22 Shut Down Peripheral Command 22, VCI, Short Packet Data 0, Short Packet Data 1

32 Turn On Peripheral Command 32, VCI, Short Packet Data 0, Short Packet Data 1

03 Generic Short WRITE, no parameters 03, VCI, Short Packet Data 0, Short Packet Data 1

13 Generic Short WRITE, 1 parameter 13, VCI, Short Packet Data 0, Short Packet Data 1

23 Generic Short WRITE, 2 parameters 23, VCI, Short Packet Data 0, Short Packet Data 1

04 Generic READ, no parameters Not applicable

14 Generic READ, 1 parameter Not applicable

24 Generic READ, 2 parameters Not applicable

05 DCS Short WRITE, no parameter 05, VCI, Short Packet Data 1, <DCS Command>
For a list of DCS commands, refer to the table DCS
Commands.

15 DCS Short WRITE, 1 parameter 15, VCI, Short Packet Data 1, <DCS Command>
For a list of DCS commands, refer to the table DCS
Commands.

06 DCS READ, no parameters Not applicable

37 Set Maximum Return Packet Size Not applicable

x0 Reserved Not applicable

xF Reserved Not applicable

DSI HS Long Packets

09 Null Packet, no data Not applicable

19 Blanking Packet, no data Not applicable

29 Generic Long Write Not applicable

39 DCS Long Write/write_LUT Command Packet Not applicable

OE Packed Pixel Stream, 16-bit RGB, 5-6-5 Format OE, VCI, WC MSB, WC LSB, R, G, B,R, G, B ...
Note: Image inserter is highly recommended to manage frame
timing.

1E Packed Pixel Stream, 18-bit RGB, 6-6-6 Format 1E, VCI, WC MSB, WC LSB, R, G, B, R, G, B ...
Note: Image inserter is highly recommended to manage frame
timing.

2E Loosely Packed Pixel Stream, 18-bit RGB, 6-6-6 2E, VCI, WC MSB, WC LSB, R, G, B,R, G, B ...

Format Note: Image inserter is highly recommended to manage frame

timing.

3E Packed Pixel Stream, 24-bit RGB, 8-8-8 Format 3E, VCI, WC MSB, WC LSB, R, G, B,R, G, B ...
Note: Image inserter is highly recommended to manage frame
timing.

x0 Reserved Not applicable

xF Reserved Not applicable

DCS Commands
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For packet types such as DCS Short WRITE, no param and DCS Short WRITE, 1 param. the DCS
Command is applicable. For such packets, you need to specify the DCS command as the last
parameter in the Data field of the packet’s line in the CSV file.

The following table provides a list of DCS commands and a code (in hex) that you can specify for
each of these commands.

Table 5 DCS Commands

Command Code (hex) Command Code (hex)
enter_idle_mode 39 read_memory_continue 3E
enter_invert_mode 21 read_memory_start 2E
enter_normal_mode 13 set_address_mode 36
enter_partial_mode 12 set_column_address 2A
enter_sleep_mode 10 set_display_off 28
exit_idle_mode 38 set_display_on 29
exit_invert_mode 20 set_gamma_curve 26
exit_sleep_mode 11 set_page_address 2B
get_address_mode 0B set_partial_areacolumns 31
get_blue_channel 08 set_partial_rows 30
get_diagnostic_result OF set_pixel_format 3A
get_display_mode 0D set_scroll_area 33
get_green_channel 07 set_scroll_start 37
get_pixel_format 0C set_tear_off 34
get_power_mode 0A set_tear_on 35
get_red_channel 06 set_tear_scanline 44
get_scanline 45 soft_reset 01
get_signal_mode OE write_LUT 2D
nop 00 write_memory_continue 3C
read_DDB_continue A8 write_memory_start 2C
read_DDB_start Al

Inserting ECC and Checksum Errors in D-PHY Stimulus

You can test how a DUT responds to error conditions such as a bad CRC or ECC in the received
packet stream by sending packets with ECC/CRC errors as stimulus to the DUT.

To insert a CRC error in a D-PHY packet

1 Open the CSV stimulus file for editing using any common text editor or a spreadsheet editor.

2 Tointroduce a CRC error in a packet, set the value of the CRC bit in the Data field to any value
other than 00. A value other than 00 ensures that the specified value is used as CRC thereby
generating a CRC error. A value of 00 ensures that the CRC is automatically calculated and
therefore a CRC error is not generated.

Example of a bad CRC
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A 4 bytes of Null Packet payload with a bad CRC
0o0o00oo0000, 1, 0,0, 0, 1,08, 04, 00, 00, 2d, da, ca, b3, EA.E

Refer to the “Structure of a CSV Stimulus File" on page 34 topic to know which field in the CSV
stimulus file represents CRC.

To insert an ECC error in a D-PHY packet
1 Open the CSV stimulus file for editing using any common text editor or a spreadsheet editor.

2 Tointroduce an ECC error in a packet, set the value of the ECC bit in the Data field to any value
other than 00. A value other than 00 ensures that the specified value is used as ECC thereby
generating an ECC error. A value of 00 ensures that the ECC is automatically calculated and

therefore an ECC error is not generated.
Example of a bad ECC in a short packet

S5 A short packet with a bad ECC
0000000000, 1, 0, 0, 0, 1, 01, 0O, 00,

Refer to the “Structure of a CSV Stimulus File" on page 34 topic to know which field in the CSV
stimulus file represents ECC.

See Also
“Structure of a CSV Stimulus File" on page 34

Inserting a Bus Turnaround (BTA) Request in D-PHY Stimulus
1 Open the CSV stimulus file for editing using any common text editor or a spreadsheet editor.
2 Toinsert a BTA request in stimulus:
a Setthe LPS bitto 1.

b Setthe Escape bitto 1 in the same line.
¢ Ensure that there is only 1 valid data byte and that data byte is OxFF.

Example of a BTA request

DDDDDLDDDD.I?I? 0, 0, D.

Data
LFs Eszcape
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Loading Stimulus Files and Starting Stimulus Transmission

Once the stimulus CSV files are ready, you can add these files in a run sequence, then load this
sequence into the memory of the U4421A module and finally start the stimulus transmission.

To get detailed information on how to create a stimulus file, refer to the topic “Creating Stimulus
Files" on page 30.

You use the Exerciser Data tab to create, open, load, and run a stimulus CSV file.

This tab has the following fields.

Field Description

File Selection - This section contains fields that allow you to create a new CSV file or select existing CSV files for processing into the stimulus data.

4

New File Click this button to invoke the CSI/DSI Image Inserter application. You use this application to generate CSV files for the
CSI/DSI protocol from the loaded images and specified parameters.

Add to List Click this button to add an existing CSV file to the list of CSV files displayed in the File Selection section.

Remove Click this button to remove an added CSV file from the list of CSV files displayed in the File Selection section.

Ignore Insert Bit

Select this checkbox to configure the U4421 module to ignore Insert bits used in the CSV stimulus files. You use an Insert
bit in a CSV stimulus file to define the specific point in the CSV file at which you can insert a packet dynamically or adjust
the lane skew settings dynamically (see PAJ€ 44) during an ongoing stimulus flow.

Therefore, when the Insert bits are ignored, the dynamic packet insertion and dynamic lane skew settings change are
disabled but you achieve accurate frame timings which are important in situations such as video mode testing (see

page 47).

For the Ignore Insert Bit setting to take effect, make sure you select this checkbox before you add CSV stimulus files to the
run sequence.

Add to Run Sequence

Click this button to add the selected CSV files from the list to the U4421A stimulus run sequence. Alternatively, you can
also double-click a CSV file from the list to add it to the run sequence.

By doing so, the selected CSV files get converted into the binary form that the U4421A module hardware can understand
and get added to the list of files in the Run Sequence section.

Run Sequence - This section displays the list of processed CSV files that you added to the list using the Add to Run Sequence button. As the name suggests, the Run
Sequence specifies the sequence in which the processed CSV files will be sent as stimulus. You can change the Run Sequence by changing the order of CSV files in
this sequence using the Move Up and Move Down buttons displayed in this section. If you do not want to send a CSV file as stimulus, you can remove that CSV file from
this Run Sequence using the Remove button displayed in this section.

For each processed CSV file displayed in this section, you can specify the Loop Count to instruct how many times the CSV file has to be repeatedly sent as stimulus in
a loop. You can either limit the loop count by a specified number or make it infinite until the Stop button is clicked.

The amount of memory utilized by each of the processed CSV file is also displayed.

Load Sequence

Click this button to load the set of processed CSV files displayed in the Run Sequence section to the U4421A hardware
memory for stimulus transmission.

The total amount of U4421A memory used by this load sequence is displayed in the Total Memory Used field in this section.

Run

Use this button to start sending the stimulus in the sequence specified in the Run Sequence section.

Stop

Use this button to stop the stimulus transmission from the U4421A module.

To load the stimulus files and start the stimulus

1

In the Exerciser Data tab, click the Add to List button to add an existing CSV file to the list of CSV
files to be used for stimulus. Repeat the step to add all the needed CSV files.

Select an added CSV file from the list and click the Add te Run Sequence button to add this file to
the U4421A stimulus run sequence.

For each CSV file added in the Run Sequence section, specify the Loop Count.

Once all CSV files have been added to the Run Sequence, click Load Sequence to load the CSV
files to the U4421A hardware memory for stimulus transmission.
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5 Click Run to start the transmission as per the defined sequence.

The following screen displays the U4421A module in the Running state. A stimulus file
master_dsi.csv is being sent repeatedly in a loop to a DUT.

Connaction Setup I Analyzer Z=tup | Exerciser Electrical | Exercisar Timing Exercizer Data | Packat Insartion

- Filz Selection

| File Mame | Size | File Path |
(i) master_dsi.csv 2.61 MB C:\Test CSV\master_dsi.cav Main Packets in a

T} Mew File... | gp Add To List... | ¥ Remove | : Add To Run Sequence |

= Fun Sequence

Fila | Loop Count I Memory Used

master_dsi.cov [Limito ~] | 100 v|| 1.28MB

Total Memory Used: 1.28 MB (Max. 4.00 GE)

¥ Load Sequence |

P Run [T Stop | Exerciser is Running
NOTE You can also start and stop the stimulus transmission from the Overview window of

the Logic and Protocol Analyzer GUI. You can use the Start Exerciser s, |~ and
Stop Exerciser =_|=| toolbar buttons displayed in

|
the main toolbar ot the GUI to do so.

You can save the defined stimulus packet sequence along with the configured stimulus settings in a
Logic Analyzer configuration (.ala) file for later usage. To do this, click File > Save, select a location
and name for the configuration file, select Standard Configuration (.ala) from the Save as type listbox
and then click Save.

Once saved, you can load a previously saved configuration file and start the stimulus as per the saved
settings.
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Only the paths to the individual CSV files listed in the File Selection field are
saved in the Logic Analyzer configuration (.ala) file. The files must be available at
the specified locations when the configuration file is loaded in the future.

The CSV File Properties icon to the left of the file name indicates an error
locating the file if the file has been moved or removed or if the specified path is
no longer valid. The specified can become invalid when a configuration file is
transferred to a new Logic Analyzer system and the relative path contained
user-login or machine-specific information. In this case, select the erroneous
CSV file, remove it from the File Selection list, then navigate to the file’s valid
path and add it again to the list using the Add To List button.
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Inserting Packets Dynamically in an Ongoing Stimulus Flow

You can use the Packet Insertion tab to insert and send packet(s) dynamically as stimulus to DUT
during an ongoing stimulus traffic flow.

When you send a packet as stimulus at runtime, the U4421A module halts the sequence of the main
stimulus flow (defined in the Exerciser Data tab), sends that packet and then resumes the main
stimulus flow from the point at which it was halted.

You can insert single or multiple packets dynamically. In case of multiple packets, these packets are
sent one after the other in a sequence and then the main stimulus flow is resumed.

The dynamic insertion of packet(s) into an ongoing stimulus flow is helpful in situations such as
injecting error packets into the stimulus traffic and checking DUT’s responses to such error packets.

The fields in the Packet Insertion tab are enabled only when you select either Exerciser only or
Exerciser and Analyzer connection mode in the Connection Setup tab.

To insert and send packet(s) dynamically during a stimulus transmission sequence

1 Create a CSV file with packet(s) that you want to send dynamically. Make sure that the CSV file
size does not exceed 32 KB. CSV files can be edited with any common text editor. A spreadsheet
editor works well for a CSV file editing.

2 You can insert packets at Stop states, or at specific points in the main data CSV file where the
Insert bit is set. If you want to insert packets dynamically at a specific insertion point in the main
stimulus flow, then define such a point by modifying the main data CSV file. To do this, you need
to set the Special field of the desired packet to “1” in the main data CSV file. The Insert bit is then
set to 1 at this point and this packet becomes the insertion point for the packets to be inserted
dynamically.

The following screen displays a main stimulus CSV file in ASCII format with a dynamic packet
insertion point defined. Notice that the Special field of one of the packets is set to 1.

// Example Main Packets in a CSI-2/DSI ASCII Format File
nsTime, LPS, Escape, ULPC, Special, Clock, Data

// Start Image Frame 1

0000051460,
0000051460,
0000102520,
0000154380,
gooozo05840,
//—— Frame
go00257300,
0000262810,
//—— Frame
00003087¢0,
gooo3l4z7o,
//—— Frame
0000360220,
0000365730,

44

0, 0, 0,1

1, 0, 0, 0, 1, 01, 00, 00, 00

i, o, o, 0, 1, 21, 00, 00, 00

1, o, o, o, 1, 21, 00, 00, 00

i, o, o, 0, 1, 21, 00, 00, 00
= 1, Line =

i, o, o, 0, 1, 21, 00, 00, 00

i, o, o, o, 1, 3e, 1le, 00, 00, ££, 00, 00, ££, 00, 00, ££, 00, 00, f£
=1, Line = 2

1, 0, 0O, , 1, 21, 00, 00, 00

0
1, o, 0, 0, 1, 3e, 1le, 00, 00, 00, ££, 00, 00, ££, 00, 00, ££, 00, C
=1, Line = 3
1, o, 0, 0, 1, 21, 00, 00, 0O
i, o, o, 0, 1, 3e, 1le, 00, 00, 00, 00, f£f, 00, 00, ££, 00, 00, ff, C
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You can define multiple insertion points in a main data CSV file. In case of multiple insertion
points, the dynamic insertion of packets takes place at the insertion point available in the
stimulus flow after you triggered the dynamic packet insertion.

If, while adding the CSV stimulus file to the run sequence, you select the Ignore Insert Bit
checkbox in the Exerciser Data tab, then the dynamic insertion of packets at the points
where Insert bits are defined is disabled.

Create a command button for the required dynamic packet insertion and send the packets
dynamically using that command button. To do this, perform the following steps.

a Inthe Setup dialog box, click the Packet Insertion tab.

b Click New.

The Button Properties Editor dialog box is displayed.

¢ Specify a name, category, and description for the command button. The command button will
be displayed with these attributes.

d Specify the complete path and name of the CSV file that contains the packet(s) to be inserted
dynamically. The file gets associated to the command button.

e From the Insert Packet at listbox, select the point at which you want the dynamic packet(s) to be
inserted in the ongoing stimulus flow. You can:

either insert packets at any stop state by selecting the Any Stop State option.

or insert packets at the insertion points that you defined in the main data CSV file by
selecting the Only where insert bit is set option. Refer to Step 2 for details on how to mark
certain packets to be used as insertion points in the main CSV file.

== Button Properties Editor

Name:

Description:

Cav File:

Insert Packet At:

CreError Category: | Error

CTestvzrcError_Packet .cswv Browsa... |

Only whers insart bit is a2t j

QK Cancel | Help |

T Click OK.

The command button gets created and displayed in the Packet Insertion tab. The following
screen displays three command buttons created under two categories.
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Connaction Setup I Analyzer S=tup | Exerciser Electrical | Exercisar Timing | Exercizer Data Packet Insertion |

# i 7 Error J MNew...
P | creError
(] Edit...
¥ | EccError
N " Delete
A s 7 Image
4 Mowe L
¥ | rgb_imags
# Mowve [
Ready

Apoly | ok |  canesl

g Clickthe —# | button displayed for a command button to dynamically insert the packets
that you associated to that command button

You can save the command buttons that you created for dynamic packet insertion along with other
settings in a Logic Analyzer configuration (.ala) file.

Only the paths to the individual CSV files listed in the CSV File field of the Button
Properties Editor dialog box are saved in the Logic Analyzer configuration (.ala)
file. The files must be available at the specified locations when the configuration
file is loaded in the future. Fix any CSV file errors before proceeding with the
Packet Insertion procedure.
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Generating DSI Stimulus for Video Mode Testing of a Display Module

To test the Video Mode operations of a display module capable of the Video Mode, you can send
pixel stream in real time from a U4421 Exerciser. To achieve this, you need to generate a CSV file
from a bitmap file using the Image Inserter application and then send this CSV file continuously as

stimulus in an infinite loop.

While doing the video mode testing, it is important that you follow the steps described in
this topic in the defined sequence. Failing to do so may result in the generation of
inaccurately timed Sync events and obstruction in the successful execution of video mode
testing.

You may also find the Troubleshooting section (on page 48) in this topic useful to resolve
problems that you may encounter while performing video mode testing.

To perform video mode testing
1 Ensure that you have selected:
correct link width in the Connection Setup tab of the Setup dialog.
correct HS Bit Rate (Mbps) in the Exerciser Timing tab of the Setup dialog.
correct Exerciser timing parameters in the Exerciser Timing tab of the Setup dialog. Accurate
frame and line timings may not be achieved if the timing parameters are not set correctly.
Launch the Image Inserter application by clicking the New File... button in the Exerciser Data tab.
Click the Non-Burst Mode tab of the Image Inserter application and perform the following steps to
create a stimulus CSV file that you can use for video mode testing.
a First, add the source bitmap file from which you want to create the CSV file (using the Add
button displayed in the Image Inserter).
b Start setting the fields from the top of the Non-Burst Mode tab and then moving down to other
fields in the tab.
¢ Lastly, adjust the time for the BLLP period(s) related fields in the tab. Once the BLLP timings
are set correctly, do not change other settings in the tab.
d Once all the settings are configured/adjusted, create the CSV file using the Create File button
and then exit the Image Inserter application.

4 In the Exerciser Data tab, ensure that the Ignore insert bit checkbox is selected. This selection is
required to achieve accurate frame timing in the stimulus sequence by disabling the dynamic
packet insertion or lane skew control changes at runtime.

5 Add the CSV file to the stimulus run sequence using the Add to Run Sequence button and then set
the Loop Count to Loop Forever.

To achieve accuracy in video mode testing, it is mandatory that the Exerciser timing,
HS bit rate, and link width settings at the time of sending the CSV file as stimulus
exactly match the settings that you used at the time of creation of the CSV file.

6 Click Run to start sending the CSV file in an infinite loop.
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Troubleshooting Video Mode Testing Related Problems

Problem Resolution
CRC errors in the trace when doing video You may need to adjust the default values of some of the Exerciser timing parameters to suit different data rates.
mode testing Increasing the HS-TRAIL and HS-ZERO parameters to a higher value in the Timing Parameters section of the

Exerciser Timing tab resolves the issue of CRC errors in the trace.

VSync to HSync time (Time for first line of Exerciser needs transmission data (including the overhead) to be in exact multiples of 256 bit blocks. At times, if

frame) is more than rest of the lines this requirement is not met, the sync timings may get distorted. To fix this problem, increase the count of VSA, VBP,
or VFP lines by 1.

Previously saved .CSV files having correct 1. In the Exerciser Data tab, select the Ignore insert bit checkbox and then reload the CSV file(s) into the Run

timings are not working as expected when Sequence section using the Add to Run Sequence button.

loaded for stimulus in LPA software release 2. If the problem still persists, re-generate the CSV file(s) using the Image Inserter dialog.

6.1 or greater
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5 Capturing D-PHY Data

Before you Start

Before you start capturing data, ensure that the following tasks are performed.

You have connected the U4421A module to the DUT using the appropriate acquisition probe in
the required configurations.

You have the licenses required for the analysis function of the U4421A module.
You have installed the Keysight Logic and Protocol Analyzer GUI, version 5.50.0000 or higher.

You have configured the U4421A module’s connection setup in the Keysight Logic and Protocol
Analyzer GUI. Ensure that you select either Analyzer only or Exerciser and Analyzer as the
Connection mode in this GUI.
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Supported Acquisition Probes

The following two acquisition probes are supported for the U4421A module.

E5405A Differential Soft Touch probe - Provides quick connection to many signals in a small footprint
without a header designed into the target. An E5405A probe is suitable for use when the DUT has
incorporated the footprint for the E5405A probe.

E5381A Differential Flying Lead probe - Can probe individual signals from multiple randomly located
points on the target system. Useful in situations when there is a space constraint on the DUT and
the footprint for the E5405A soft touch probe cannot be incorporated on the DUT.

For detailed information on these probes and how to make connections with the U4421A module and
DUT, refer to the U4421A MIPI D-PHY Analyzer and Exerciser Hardware and Probing Guide. The
guide is available on www.keysight.com/find/dphy_analyzer and also installed with the Keysight
Logic and Protocol Analyzer software.
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Configuring Data Capture Settings

Once the hardware is set up for using the U4421A module to capture D-PHY data, you can configure
the data capture settings in the Logic And Protocol Analyzer GUI. In this Setup Ul, you use the
Analyzer Setup tab to configure the timing settings for the module.

_ The fields in the Analyzer Setup tab are enabled only when you select either Analyzer only or
NOTE Exerciser and Analyzer connection mode in the Connection Setup tab.

The Analyzer Setup tab has the following fields that you can modify to configure the capture settings.

Field Description

Capture Setup

Enable Raw Data Capture The U4421A module can capture both protocol level and raw signal level data simultaneously. The protocol level data
capture is always enabled. You can choose to enable or disable the raw signal level data capture.
You can instruct the U4421A module to capture the raw signal level data by selecting the Enable Raw Data Capture
checkbox.

Raw Data Capture Memory Depth The total memory depth that is licensed and available for the U4421A module is shared between the Exerciser and Analyzer

functions of the module. Within the Analyzer function, it is further shared between the Protocol level data acquisition and

raw signal level data acquisition (if enabled).

From the Raw Data Capture Memory Depth listbox, select the memory depth that you want to allocate to the acquisition of

the raw signal level data. This listbox is disabled if you deselected the Enable Raw Data Capture checkbox.

You can allocate a value ranging from 64 KB to 8 GB as the Raw Data Capture Memory Depth depending on:

= the total memory available on the installed license of the U4421A module.

= the connection mode selected for U4421A in the Connection Setup tab.
Exerciser Only - No memory is available to the Analyzer function of U4421A. The Raw Data Capture Memory Depth
field is disabled in this case.
Exerciser plus monitor - The raw data capture is not available in this mode. Therefore, the Raw Data Capture
Memory Depth field is disabled in this case.
Exerciser and Analyzer - In this mode, the memory is shared between the Exerciser function’s transmit memory
depth and Analyzer function’s Protocol data and Raw data capture memory depths. You allocate the memory to the
Protocol data and Raw data capture memory buffers. After these allocations, the memory that remains from the
total memory is then automatically allocated to the Exerciser function’s transmit memory depth. For the license with
16 GB memory, you can have a value less than or equal to 4 GB to each of these three memory depths.
Analyzer only - In this mode, you need to divide the memory between the Protocol data and Raw data capture
memory depths. While dividing the memory between these two buffers, ensure that the sum of the two allocations
should not exceed the total memory available on the installed license. For the license with 16 GB memory, you can
allocate a value less than or equal to 8 GB to each of these two memory depths.
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Field Description

Protocol Data Capture Memory Depth

The total memory depth that is licensed and available for the U4421A module is shared between the Exerciser and Analyzer

functions of the module. Within the Analyzer function, it is further shared between the Protocol level data acquisition and

raw signal level data acquisition (if enabled).

From the Protocol Data Capture Memory Depth listbox, select the memory depth that you want to allocate to the

acquisition of the protocol level data.

You can allocate a value ranging from 64 KB to 8 GB as the Protocol Data Capture Memory Depth depending on:

= the total memory available on the installed license of the U4421A module.

= the connection mode selected for U4421A in the Connection Setup tab.

+ Exerciser Only - No memory is available to the Analyzer function of U4421A. The Protocol Data Capture Memory

Depth field is disabled in this case.
Exerciser plus monitor - The raw data capture is not available in this mode. Therefore, the total memory is shared
between the Exerciser function’s transmit memory depth and Analyzer function’s protocol data capture memory
depth. You allocate the memory to the Protocol data capture memory buffer. After this allocation, the memory that
remains from the total memory is then automatically allocated to the Exerciser function’s transmit memory depth.
For the license with 16 GB memory, you can allocate a value less than or equal to 8 GB to each of these two
functions.
Exerciser and Analyzer - In this mode, the memory is shared between the Exerciser function’s transmit memory
depth and Analyzer function’s Protocol data and Raw data capture memory depths. You allocate the memory to the
Protocol data and Raw data capture memory buffers. After these allocations, the memory that remains from the
total memory is then automatically allocated to the Exerciser function’s transmit memory depth. For the license with
16 GB memory, you can have a value less than or equal to 4 GB to each of these three memory depths.
Analyzer only - In this mode, you need to divide the memory between the Protocol data and Raw data capture
memory depths. While dividing the memory between these two buffers, ensure that the sum of the two allocations
should not exceed the total memory available on the installed license. For the license with 16 GB memory, you can
allocate a value less than or equal to 8 GB to each of these two memory depths.

Analyzer Input Threshold

Set the threshold used to detect state changes of the LP signals. Ensure that you set the threshold as close as possible to
the middle of the LP signal swings, but safely above the maximum signal swing of the HS data. To set the threshold, you can
either select predefined options for busses meeting the standard specifications or specify a custom value to set a specific
voltage.
= Standard LP Thresholds - Allows you to select a threshold from the three available options.
Dynamic Differential 100 Ohms - The U4421A module supports the MIPI D-PHY standard for accepting the
differential inputs (a 100 ohm resistor between the signals).
Static Differential 100 Ohms
Open circuits - Supports un-terminated single-ended receiver.
= Custom LP Thresholds - Allows you to specify a value for the input threshold within the range of -1000 to +5000 mV.

Bit Rate

Set the HS bit rate used by your DUT. Ensure that the bit rate that you specify is within the HS bit rate range (80 Mbps -
1500 Mbps) supported by the U4421A module.

You can use the Measure Value button to measure the bit rate, if connected to a running system with proper thresholds set.

Timing Parameters

By default, the U4421A module acquires data with timings that comply with the MIPI D-PHY specifications.

The parameters that control these timings are displayed in the Timing Parameters section. These timing parameters are
displayed with their default values (for the selected Bit Rate) auto-calculated according to the MIPI D-PHY specifications.
You may want to adjust these default timings to accommodate a DUT that has non-standard timing requirements. In such
situations, you can edit the values of timing parameters. Timing adjustments are made with multiples of 5 ns resolution.
The value you enter will be rounded down to the value permitted by the resolution.

Clicking the Default button displayed in this section reverts the values of all timing parameters back to the MIPI D-PHY
specification default values for the selected bit rate.

Moving the mouse pointer over the values displayed under the column [Spec values] displays a tooltip. This tooltip
describes the timing parameter associated with that spec value. ) o

Refer to the topic “USing Timing Parameters to Determine the Occurrence of Timing
Errors" on page 54 to know how these parameters impact timing error calculations.

In-Circuit Sampling Optimization

This section provides the Run In-circuit Optimization button. You can use this button to initiate the automatic tuning
process to tune the U4421A module to the actual signals of the target system. It optimally aligns the clock to the center of
the data eye on each lane. It assumes that at the data source, the skews between clock and data lanes are within
specifications.

This is recommended for high-speed (>1Gbps) systems.

NOTE The D-Phy bus must be generating continuous High Speed data in order for this feature to work.
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Using Timing Parameters to Determine the Occurrence of Timing Errors

The following table describes how you can use the timing parameter values specified in the Analyzer
Setup tab to determine when timing errors occur in the acquired data. Based on these values, the
U4421A module flags timing errors in the acquired data.

Timing Parameter How it helps you determine when a timing error occurs

HS-PREP (Max) When the time specified as HS-PREP (Max) expires, the U4421A module starts looking for a sync
pattern. Therefore, make sure that HS-PREP (Max) is more than HS-Settle.

HS-ZERO+HS-PREP (Max) If the time from LP-00 to sync byte is less than HS-ZERO+HS-PREP (Max), then a data lane SOT
error is flagged.

HS-TRAIL (Min) If the time from the last transition to LP-11 is less than HS-TRAIL (Min), then a data lane EOT error
is flagged.

CLK-POST (Min) If the time from when a data lane transitioning to LP-11 to the time when the clock stops toggling

is less than CLK-POST (Min), then a clock lane Data error is flagged.

T-LPX (Min) If the time from any LP edge to an adjacent LP edge is less than T-LPX (Min), one of the following
errors is flagged:
= Clock SOT error
= Data TA (Turnaround) error
= Data ESC (Escape mode) error
= Data SOT error

CLK-TRAIL (Min) If the time from the last clock lane transitioning to clock lane LP-11 is less than this value, a clock
lane EOT error is flagged,

CLK-PRE (Min) If the time from when the clock is running to the time when the data lane transitions to LP-01 or
LP-10 is less than CLK-PRE (Min), a data lane Data error is flagged.

TA-TIMEOUT During a BTA, if an LP-10 is not driven by the peripheral within the time specified as TA-TIMEOUT, a
TATO error is flagged.

After you have configured the capture settings, save the settings in a Logic Analyzer configuration
(.ala) file. To do this, click File > Save, select a location and name for the configuration file, select
Standard Configuration (.ala) from the Save as type listbox and then click Save.
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Setting up Triggers

You can trigger the U4421A module to start storing the captured data in its memory when the
specified trigger condition is met. For instance, you can specify the transmission of a D-PHY packet
with the Ecc error in its header as the trigger condition for data storage in memory.

You can set a Simple or an Advanced trigger.

Simple trigger - A simple trigger allows you to quickly set up a trigger without getting involved into
setting up multi-level sequenced steps for the trigger. In this type of trigger, you can include one
or more trigger events whose occurrence causes the module to trigger the storage of the
captured data.

Advanced trigger - An advanced trigger allows you to set up a complex multi-level sequenced
trigger. In an advanced trigger, you can include multiple steps. In each step, you can define one
or more trigger events and the action that should be performed with the occurrence of that event.

Based on the type of trigger (Simple or Advanced) that you are setting up, a trigger setup may be
comprised of a trigger position, type, mode, store qualification, condition(s), and action. All these
components of a trigger are set up using the fields displayed in the Trigger dialog box.

You access the Trigger Dialog box by selecting Setup>Trigger.... from the Keysight Logic and Protocol
Analyzer GUI's menubar.

The following table has descriptions of all the fields available in this dialog box for setting up a simple
or an advanced trigger.

Field Description

Link tabs The top of the Trigger dialog™ | llows you to add tabs that let you set up separate triggers for different MIPI D-PHY links.
You can add tabs using the icon and then apply these tabs to different links that are set up in the Connection Setup
tab of the Setup dialog box.

Applies to Displays the MIPI D-PHY links that are set up in the Connection Setup tab of the Setup dialog box. Selecting one ore more
links from the Applies to drop-down listbox applies the trigger settings in the current tab page to the data captured on the
selected links.

Trigger Position Defines the trigger position within the acquisition memory of the U4421A module. The selected trigger position on the

slider sets the pre and post trigger memory ratio. By default, the available acquisition memory is equally divided between
the pre and post trigger memory.

Favorite Triggers

Displays a drop-down menu for:

= opening a previously saved trigger setup.

= saving the currently configured trigger setup in a Trigger Setup (.trg) file.

= viewing and accessing a list of recently accessed trigger setup files.

Note: The favorite trigger setups referred in this drop-down menu are different from the favorites list that appear in the
left-side events pane. In the left pane, the list of favorites refer to the favorite trigger events that you added, edited, and
saved to the favorites list using the Event Editor dialog.

Clear

Clears the current trigger settings that you configured in the current tab and restores the default settings.

For setting up a Simple Trigger - The following fields are applicable for a simple trigger.

Simple Trigger

Select the Simple Trigger radio button. Selecting this radio button displays the fields relevant for setting a simple trigger in
the Trigger dialog box. These fields are described below.
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Field Description

List of events In the left pane of the Trigger dialog box, an expandable list of events is displayed based on the protocol family (CSI-2, DSI,

D-PHY) applicable for the U4421A module. The events in this list are organized based on categories such as:

= Types of D-PHY packet or ordered set - Categorized on the basis of HS Short, HS Long, LP Short, and LP Long packet
types.

= Physical Layer triggers - The transmission of an erroneous packet, for instance, with Crc, Clock, Ecc, or Lane error sets
the trigger.

= Arming - The U4421A module can receive triggers from another module installed in the AXle chassis or another device
with which it is connected via the Trigger in Connector on the AXle chassis.

You can select one or more of these events to act as trigger condition(s).

Trigger Mode = Select the Trigger on Packets or Ordered Sets radio button to ensure that the U4421A module is triggered on the
occurrence of the trigger event(s) included in the Select the Trigger(s) to use section.

= Select the Trigger when Stop button pressed radio button to ensure that the U4421A module is triggered to store the
captured data when you click the Stop button to stop the data capture. On selecting this option, the trigger events are
not applicable. Therefore, the Select the Trigger(s) to use section is disabled.

Global Filter This feature is not currently supported.

This listbox lets you define the data that should be stored in the acquisition memory of the U4421A module on the
occurrence of the trigger event. Currently, the listbox is disabled and all the acquired data is stored in the acquisition
memory when the trigger condition is met.

Select the Trigger(s) to use = Trigger on any of these events - You can drag events from the list of events displayed in the left pane and drop these
events in this section. The U4421A module is triggered on the occurrence of any of the events included in this section.

= While ignoring any of these events - You can drag events from the list of events displayed in the left pane and drop
these events in this section. The U4421A module is not triggered on the occurrence of any of the events included in this
section.

To edit events included in the above-mentioned sections, click the underlined event name. This displays the Event Editor

dialog box to let you edit the event properties or add the event to the list of favorite events.

To remove events from the above-mentioned sections, click the "X" displayed to the left of the event name.

For setting up an Advanced Trigger- The following fields are applicable for an advanced trigger.

Advanced Trigger Select the Advanced Trigger radio button. Selecting this radio button displays the fields relevant for setting an advanced
trigger in the Trigger dialog box. These fields are described below.

List of events In the left pane of the Trigger dialog box, an expandable list of events is displayed based on the protocol family (CSI-2, DSI,

D-PHY) applicable for the U4421A module. The events in this list are organized based on categories such as:

= Type of D-PHY packet or ordered set - Categorized on the basis of HS Short, HS Long, LP Short, and LP Long packet
types.

= Physical Layer triggers - The transmission of an erroneous packet, for instance, with Crc, Clock, Ecc, or Lane error sets
the trigger.

= Timers, counters, and flags - Sets trigger on a timeout or the expiry of a counter. The U4421A module can also receive
triggers from another module installed in the AXle chassis or another device with which it is connected via the Trigger
in Connector on the AXle chassis. The Arm In from event is used in such a situation.

= Comment - Allows you to add comments to your advanced trigger setup.

You can select one or more of these events to act as trigger condition(s).

Global Filter This feature is not currently supported.

This listbox lets you define the data that should be stored in the acquisition memory of the U4421A module on the
occurrence of the trigger event. Currently, the listbox is disabled and all the acquired data is stored in the acquisition
memory when the trigger condition is met.

Select the Trigger(s) to use By default, this section displays a single step with an ‘If - then’ specification for the trigger condition and subsequent

action. If required, you can add more steps in this section to set up a complex multi-level sequenced trigger.

This section has the following fields:

= The Step button allows you to add or delete steps from the sequence.

= The If/Else if buttons let you insert additional “If” clauses in the same step or delete an additional "if" clause from the
step.

= Toadd multiple conditions / actions for a step, drag the required event from the list of events in the left pane and drop
it to the step box.

= The event chevron buttons let you insert, delete, or logically group (or negate) events.

= The action chevron buttons let you insert or delete actions.
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To set up a simple trigger

1 Inthe Keysight Logic and Protocol Analyzer GUI's Overview window, click the D-PHY module and
select Setup>Trigger.... from the drop-down menu. Alternatively, click the [Ttid| icon displayed for
the D-PHY module.

Modules Wyindows

8 D10z ‘ EH Protocol

2 Wiemver-1

NEE |

o ‘ Mew Probe 3
Mew Tool 3
e indow b . Waveform-1
Disable, .. L Trigger. ..
Rename...

The Trigger dialog box is displayed.

2 From the Applies to listbox, select the MIPI D-PHY link(s) to which you want to apply the trigger
settings.

3 If required, use the Trigger Position slider to change the default trigger position (50%) for the
allocation of pre and post trigger memory.
Select the Simple Trigger radio button. All simple trigger related fields are then displayed.

5 Select the Trigger Mode. On selecting the Trigger on Packets or Ordered Sets radio button, the Select
the Trigger(s) to use section is displayed in which you can add trigger events. For the Trigger when

Stop button is pressed option, trigger events are not applicable. Therefore, you cannot add any
trigger events on selecting this option.

6 Drag and drop the desired trigger event(s) from the event list in the left pane to the Trigger on any
of these events section on the right.

7 To change an added trigger event’s properties, click that event’s underlined name in the Trigger
on any of these events section.

8 To delete an added trigger event from the Trigger on any of these events section, click the “X” to the
left of the event name.

9 From the event list in the left pane, drag the required events that you want to exclude and drop
these in the While ignoring any of these events section.

10 Click Apply.

11 To save the currently configured trigger setup in a Trigger Setup (.trg) file, click the Favorite
Triggers button and then select the Save option from the displayed drop-down menu.

12 Click OK.
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To set up an advanced trigger

1 Inthe Keysight Logic and Protocol Analyzer GUI's Overview window, click the D-PHY module and
select Setup>Trigger.... from the drop-down menu. Alternatively, click the [Ttid| icon displayed for
the D-PHY module.

Modules Windowes
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o
i Setup..
il Trigger. ..
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The Trigger dialog box is displayed.

2 From the Applies to listbox, select the MIPI D-PHY link(s) to which you want to apply the trigger
settings.

3 If required, use the Trigger Position slider to change the default trigger position (50%) for the
allocation of pre and post trigger memory.

Select the Advanced Trigger radio button. All advanced trigger related fields are then displayed.

5 As per your specific requirements:
a Edit the default step (Step 1) to select the trigger condition and action in the “If-Then” clause.
b Add more “If-Then” clauses to a step by clicking the If/Else If button in the step.

¢ Add more than one And/Or condition to an “If” clause of a step by clicking the button for
events. You can also negate a condition by selecting the “Insert Not at beginning of row”

option from the drop-down menu.

d Add more than one action to “Then” clause of a step by clicking the button for actions.

e Add more steps before or after a step by clicking a Step button.
6 Click Apply.

7 To save the currently configured trigger setup in a Trigger Setup (.trg) file, click the Favorite
Triggers button and then select the Save option from the displayed drop-down menu.

8 Click OK.
Trigger Examples
The following are some examples of trigger setups for capturing D-PHY data.

Simple trigger examples

The following trigger setup aims at triggering the U4421A module on the transmission of any Sync
Event packet except the H Sync End (HS) packet.
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The following trigger setup triggers the U4421A module on the transmission of a packet with any of
the errors included as trigger events.
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Capturing D-PHY Data 5

Starting and stopping the Data capture

Once the capture setup and trigger setup are ready, you can start capturing the D-PHY data.

To start the data capture, choose Run/Stop>Run from the Logic and Protocol Analyzer GUI's menubar.
Alternatively, click the | = icon from the toolbar.

For more information, see the Running/Stopping Measurements topic in the Logic and Protocol
Analyzer Online Help.

On starting data capture, the Status section at the bottom of the Logic and Protocol Analyzer GUI is
updated to reflect the current status of the data capture procedure.

The status moves from the Processing, Running, and finally to Filling Memory state.

Capture Status Description
Processing The module is processing the data capture settings to initiate data capture.

Status. [Fracessing...
Running The U4421A module is now in the Running state to capture D-PHY data.

Status. | Running...

— |

Filling Memory The trigger condition is met. The U4421A module is now triggered to start storing the captured data in its
memory.

Status. |[Filing Memary [DSI-101] ...

To stop the data capture, click the 'l | icon from the toolbar.

0 If you are using both the exerciser and analyzer functions of the U4421A module, then start
NOTE the exerciser prior to attempting to capture data with the analyzer. To start the exerciser, you

can use the Start Exerciser =, |,lr toolbar button in the Logic and Protocol Analyzer GUI.
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This chapter provides information on how to view and analyze the captured D-PHY data for testing
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6 Viewing and Analyzing Captured Data

Overview

64

After you have captured D-PHY data using the U4421A module, you can view and analyze this data

in the Keysight Logic and Protocol Analyzer GUI in the following two modes:

- Online - In the Online mode, the U4421A hardware is still connected and needed for viewing the
captured data.
Offline - For the Offline mode, you can save the captured data and configurations in a Logic
Analyzer configuration file (.ala extension). You can later load this file in the Logic and Protocol
Analyzer GUI to view and analyze data offline (without the U4421A module connected).

You can also export the captured data to CSV format files for offline viewing and analysis in
applications other than the Logic and Protocol Analyzer GUI.

For viewing the captured data in online or offline mode, various viewers are available in the Logic and
Protocol Analyzer GUI. Each viewer has its own set of features for the presentation of captured data

and is useful for specific situations.
Viewer Usage Notes

Protocol Viewer = To view protocol level packet data. Packet An instance of Protocol Viewer is automatically
details are organized and viewable in different added and available in the Logic and Protocol
forms using different views available in Protocol ~ Analyzer GUI when you create a new session of the
Viewer U4421A module.

= Also provides the licensed feature - Image
Extractor to construct images from the captured
data.

Waveform Viewer To view both packet as well as raw signal data. An instance of Waveform Viewer is automatically
added and available in the Logic and Protocol
Analyzer GUI when you create a new session of the
U4421A module.

Listing To view raw signal level data If needed, you can add instance(s) of this viewer to
the U4421A module by selecting New Window >
Listing option in the Overview pane.

Modules Windows

8 Dsioos B Protocol

Yiewer-1

. Wy aweform-1
D=

B Listing-1
OE=N
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In the above screen, a Protocol Viewer and a Waveform Viewer are already added on starting a new
session and a Listing viewer has been added manually.

The topics that follow describe how to use each of the available viewers for viewing and analyzing
captured data.

The information about viewers in the following topics is specific to viewing and
analyzing D-PHY data. To get general information about a viewer, its fields, or
how to use it, refer to the topics in Reference > Windows section of the Logic
and Protocol Analyzer Online Help.

Keysight U4421A MIPI D-PHY Analyzer and Exerciser User Guide

65



6

Viewing and Analyzing Captured Data

Viewing D-PHY Packet Data Using the Protocol Viewer Display

66

The information about the Protocol Viewer in this topic is specific to viewing and analyzing
D-PHY packets. To get general information about the Protocol viewer, its fields, or how to
use it, refer to the following topics in the Logic and Protocol Analyzer Online Help.

- Reference > Windows > Protocol Viewer Display Window
- Analyzing the Captured Data > Analyzing Packet Data

The Protocol Viewer window provides various ways of viewing the captured D-PHY packet data. You
can view summarized as well as detailed packet information at the same time within the upper and
lower panes in this window.

The upper pane of the Protocol Viewer displays a summarized list of captured D-PHY packets. The
Protocol Viewer window is customized for the protocol family being decoded. For a D-PHY packet, it
displays the D-PHY related decoded fields. In the following screen, the captured packet details
specific to the DSI protocol are displayed.
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Fackstsz

b2 = Sample Numbe Time MIPI-D3I Packet Data ID ¥YCI Data Type Word
2063 12, 252583 ms FPPS Z4b RGE §:5:3 (HI) 3E 0 3E nlcz
2064 12, 255471 mz H Synec Start (HY) 21 0 21
2065 12, 255950 ns FPS Z4b RGE G:G:8 (H3I) 3E 0 3E alcz
2065 12, 259370 nz Reserwed H3C [LP) 3C 0 3C
2067 12, 262286 nz PPS Z24bh RGE 5:5:8 (H3) 3E 0 3E alcz
20635 12, 265710 ns EReserwed HZD (LP) 2D 0 2D
1] I

Detzils | Header | Fayload | Lanes ' Trafiic Overnew | Imaoge View | Compare 1
Ciata Range [ ]include Errors - Mavigation

Beginning Of Data  » | to: |End Of Date w E] 'IB-::ut-c:-fDevents

= Mlmg%lhpw | Packets DSI-102! Total
= ort Packet — ‘e )
¥ Syne Event Sync Event, WV Sync Start (HS) 3 a
% Generic Short WRITE Sync Event, H Sync Start (HS) 2401 2401
+ Genenc Short Read
# DCS Short WRITE Sync Event. ' Sync End (HS) 5 8
= HS Long Packet Packed Pixel Stream, 24-bit RGB, 8:8:8 Format (HS) 2515 2515
# Image Data
= HS Resarved Mull Packet, no data (HS) 4 4
=l LP Short Facket . .
: 5;’1‘: Ever: Blanking Packet, no data (HS) 4 4
+ (Generic Short WRITE Sync Event. V Sync Start (LP) 4 4
+ Genenc Short Read .
3 DCS Short WRITE Sync Event, H Sync Start (LP) 16 16
= LP Long Packet ¥ | Packed Fixel Stream, 24-bit RGE. 888 Format (LP) 4 4
< > | Mull Packet na data (I P) 4 4

j Overview . % Praotocol Yiewer-1 J W aveform-1 J
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Color Coding used in the Protocol Viewer Window

The following color coding is used to display various packet types in the Protocol Viewer window’s

upper pane.
Short Packet Blue
Packsts
ﬂ Jample Numbe Time MIPI-D3I Packet
2064 12, 255471 m=z H Synec Start (HS)
Long Packet Green
FPackets
EE Jample Humbe Time MIFI-D3I Packet
2063 12, 252583 n=s PPS Z24db RGE §:8:8 (HI)
LPDT Escape Commands Yellow
Packets
ﬂ Jample Number Time MIPI-DSI Packet
21 9.964 uz Ultra-Low Power state [(mode)
Reserved Orange
Packsts
£ Jample Numbe Time MIPI-D3I Packet
20aa 12. 259370 ns Reserwved H3C (LF)
Packets with Errors Red
Packet=
M2 : Fanple Number MIPI-D3I Packet

iPPS 24b RGE 5:8
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You can identify if a packet was transmitted in HS or LP operation mode. A packet transmitted in the
High Speed mode is displayed with the label (HS) appended in the packet name in the upper pane of
the Protocol Viewer. The label (LP) is appended to the packet name to indicate Low Power operation

mode.
Show-| All Channels ez | | _|__| ‘nl Hl Pl L| lel|£€ =
Packets
k2 - Sample Number Tinme MIPI-DSI Packet Data ID

lda6 5.2200581 ms PR3 24b BEGE S:8:5 (HI) 3E
1467 E.226719 m=s H Svync Start (HI) 21
1485 L.Z227196 m= PP3 Z4db EGE 5:8:85 (HSI) ZE
1463 5.235383% ms H Svync Start |[(H3) 21
1470 L.234319 m=s PP3 24db EGE 5:8:8 (HI) 3E
1471 5.241487 m=s H Symc Start |[(LF) 21
147 2 5.244938 ms PP Jeb RGE l12:12:1:2 (LF) 1D

You can also view this information for a packet in the Details tab in the lower pane of the Protocol
Viewer. The Details tab shows the State of Line and Lane Mode applicable for the D-PHY packet

selected in the upper pane.

Details | Header | Fayload | Lanes | Traffic O

Show only Favorite Fields w P:

= Generated Fields

Direction = DSI-102

Size {Bytes) = 1158

Link Direction = Forward
State Of Line = Low Power 3ate
Lane WMode = LFOT
Clock Error

Lane 0 Error = Esc Error
Lane 1 Error

Lane 2 Error

Lane 3 Error
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Details | Header | Fayload | Lanes | Traffic Overvis

Show only Favonte Fields « Sync Ev

= Generated Fields

Direction = DsI-102

Size (Bytes) =4

Link Direction = Forward
State Of Line = HS Transmission
Lane Mods = HS

Clock Error

Lane ¢ Error= 30T Error
Lane 1 Error

Lane 2 Error

Lane 3 Error
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Viewing the Lane-wise Transmission of D-PHY Data

The Lanes tab in the lower pane of the Protocol Viewer provides a vertical listing of raw data for
packets spread across the logical data lanes on which the data was transmitted. The logical lanes are
organized as columns in the Lanes tab. The number of Lanes column displayed depends on the
number of D-PHY lanes used in the link for transmission.

When you select a D-PHY packet listed in the upper pane, its raw data spread across the logical
lanes used for the transmission is highlighted in the Lanes tab. Similarly, when you select a raw data
row in the Lanes data, the packet to which it belongs is highlighted in the upper pane.

The display of raw data for each lane in the Lanes tab does not depend on
whether or not you enabled the Raw data capture feature in the Analyzer Setup
tab.

The data displayed in the Lanes tab is particularly useful in situations when packet data cannot be
interpreted due to errors in transmission.

In the following figure, the data of an H Sync Start (HS) packet spread across the four logical lanes
used for its transmission is highlighted. Notice that four columns are displayed to represent the data
lanes of a x4 link. The same color coding is used for the packet in the upper pane and its data spread
across the lanes in the lower pane.

Packsts

b2 - Sample Number Time MIPI-D3I Packet Data ID YCI |Data Type
1041 l.581l68 ms PPS Z4b RGE S:5:5. 3E 1] 3E
1042 1.863136 mz H Sync Start [(HS) 21 1] 21
1043 1.570334 mz H 3ync Start (HI) 21 1] 21
1044 1.5870766 ms PPS Z24bh RGE 5:5:5. 3E 1] 3E
1045 1.872734 nz H 3ync Start [(HS) 21 1] 21
1045 1.573166 ms PPS Z4b RGE S:5:8. 3E 1] 3E
1047 1.5875566 ms PPS Z4bh RGE S5:5:5. 3E 1] 3E
Tiﬂﬂ 1 8775834 m=  H Ssme Start (HSE) 21 n 71

Detgils | Header | Fayload  Lames | Traffic Overview | Imaoge View | Compare 1

B2 Z| Time DsE-101

{ Symbol Time ) | Sample Number Llane 0 | Lanel lane 2 Lane 3

1.862598 ms 1041 FE FF FF FF
1.862603 ms 1041 FE FE GaC 09
1.863136 ms 1042 21 a0 [ii] 12
1870334 ms 1043 21 a0 (i]i] 12
1.870766 ms 1044 3E TA 04 26
1870771 ms 1044 FE FE FF FE
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6

The Payload tab displays the decoded payload for the packet currently selected in the upper pane of
the Protocol Viewer.

The following screen displays the payload of a CSI-2 RGB image packet. The image’s pixel bytes data

is shown.
816 us RGEEGE (H3) 2z
Z3Z us RGEGRE (H3) 23
hd2 4 |

Details | Header " Payload | Lanes | Traffic Overview |

Pixels Per Row | 1 |E|—|+'
Pixel Red Green Blue Color
o0 [sF oo o [N
1 aF 36 00
2 aF 36 00
3 aF 36 00

Changing Decode Settings for RAW Image Payload Data

For RAW image formats, the Payload tab also provides the Change Image Decode Settings button. By
default, RGB presets are used for decoding the payload of RAW image formats. However, you can

use the Change Image Decode Settings button to select different decode settings for the image payload
data. Clicking this button displays the Raw Image Decode Settings dialog box.

& 555.562 us RAWGe (H3) 28 1] 28
4 832.4l6 us PAWE [(HS) 28 a 28
5 1.109269 ms RAWG (H3) 28 1] 28
5] 1.3861l2Z ms PAWE [(HS) 28 a 28
7 1.662956 ns RAWG (H3) 28 1] 28
8 1.939841 ms PAWeE (HS) 28 a 28
£l 2.216693 ms RAWG (H3) 28 1] 28
10 2.493546 ms PAWE [(HS) 28 o 28

ol

Details | Header ' Faybad| Lanes | Traffic Overview | Image View |

Pixels Per Row: | i | B =] +. [Change Image Decode Settings...|
Pixel Red Green Blue

0 1E

1 D

3 1F

4 10

[ 1F

7 D

3 10

10 c

12 18

13 19

H Ra&W Trnage Decode Settings

Presets: | RGE > |

Mumber of rows in calor map:

Mumber of colors in pattern:

Color Map

[Red

- [Green

v[B|UE v|
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For RAW formats, a number of preset options such as RGB, YMC, CMY, and Bayer decoding are
available in the Raw Image Decode Settings dialog box. Based on the decode settings that you select
in this dialog box, the image’s payload data is recalculated in the Payload tab. The changed settings
are also applicable while extracting an image in the Image View tab.
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Viewing the Captured D-PHY Traffic Statistics

The Traffic Overview tab in the lower pane of the Protocol Viewer provides an overview of the D-PHY
traffic listed in the upper pane. It provides a count of various types of captured D-PHY packets
categorized on the basis of the type of packet. It also displays the count of D-PHY packet errors.

[+ Sync Event
[+ Gensric Short WRITE Packed Pixel Stream, 12-bit YCCr, 4:2:0 Farmat (HS 2455 2458
[ Genernc Short Read

Detzils | Header | FPayload | Lanes  Trafhic Overnew | Imaoe View | Compares 1
Data Range Include Errors -~ Nawvigation
|Beginning O Diata v| tor |En|:| Of Data v| [ Compute ] | H| ||("v G 1 B
= L—';-é“;ﬂ"‘-“- 'P""'k Packsts DSI-102 Total
= i t
& e E_f:nf Bad Header ECC 5434 5434
g gener!c gnog EiﬂlgE Bad Payload CheckSum 6214 6214
+ Generic Short Rea
& DCS Shert WRITE Sync Event. V Syne Start (HS) 2327 2327
S| "g annggEPEg‘L:T 'End of Transmission packet (HS} 3108 3108
= H5 Ressned Sync Event. H Sync Start (HS) Ay
= LP Short Packet

Packed Fixel Stream, 16-bit RGE. 5:6:5 Format (HS) 1562 1562

= DCS Shart WRITE Packed Fixel Stream, Z4-bit RGE. 8:8:8 Format (H5) 2914 2914
= LP Long Facket Sync Event, H Sync End (HS) 781 7R
# Imzge Data - -
= LP Reserved Packed Fixel Stream, 16-bit YCbCr. 4:2:2 Format (HS S
S hzgghgﬁmﬁﬂﬂpf;?g;“r@rﬂram Color Mode {CM) O Command (HS) 1475 1475
= LPDT E=scape Commands | Shut Down Penphersl Command (HS) 1397 1387
Errors Generic Short WRITE. no parameters {HS) 1394 1234
< 3 Genenc Short \WRITE. 2 parameters (HS) 1381 1331

To view D-PHY traffic statistics

Click the Traffic Overview tab.

In the Data Range group box, specify the range of data (from the upper pane) for which you want
to compute and display traffic statistics. You can also select markers set in the upper pane for
defining the data range.

Select the Include Errors checkbox if you want a count of errored packets to be included and
displayed in the traffic statistics.

Click Compute.

Traffic statistics are displayed for the selected data range. The left pane lists the packet types for
the applicable protocol. Selecting a packet type from this list displays the total number of
packets in the data range for that packet type.

Use the Navigation section in the Traffic Statistics tab to navigate through the packets of a
particular type in the upper pane.

a Select a packet type from the right pane of Traffic Statistics.

b Inthe Navigation section text field, specify the packet occurrence to which you want to
navigate in the upper pane.

c Click Go.

The specified packet occurrence is highlighted in the upper pane.
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The last packet type “Errors” listed in the left pane displays the count for the

NOTE errored packets categorized on the basis of errors types. This error count is
displayed only if you selected the Include Errors checkbox before computing
traffic statistics.

Extracting Images from the Packet Data

You can use the Image View tab in the lower pane of the Protocol Viewer to display images
constructed from the captured packet data. The Image View tab lists all the “Start of Frame”
locations for images found in the captured data range specified by you. An image can be constructed
from a selected “Start of Frame”.

" Details | Header | Payload | Lanes | Traffic Oveniew * Image View | Compare 1 |

74

Data Range Display Time as:
[Beginning OfData = ] to: [End Of Data V] Find - [ Show Image... l [ Export list to C5V... l [ Save All Images... | | @ Absolute () Relative
Frame Mumber ~ Sample Number Time Module
00 1] 2.580 us Dsk-102
01 0 8362346 ms Dsi-102
02 0 16563774 ms Dsi-102

All data formats in the CSI-2 and DSI specifications are supported for image construction in the
Image View tab.

NOTE You need the Image Extractor software license to display images constructed from the

captured packet data.

To extract an image
1 Click the Image View tab.

2 In the Data Range fields, select the range of the captured data from which the Start of Frame
locations are to be displayed.

3 From the Display Time as section, you can choose to display the Start of Frame locations with their
absolute time or the time relative to their previous frames. The default selection is Absolute.

4 Click Find.
All the “Start of Frame” locations from the captured data as per the data range specified by you
are listed in the Image View tab.

5 Select a start of frame from the displayed list and click the Show Image button to get an image
constructed from the selected start of frame.
At this step, an error message is displayed if you do not have the appropriate software license to
use the Image Extractor feature.

If you have the appropriate license, the image is constructed and displayed in the Extracted Image
dialog box. The constructed image’s attributes such as width, height, format, and decoding
options are also displayed.
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A sample image constructed is displayed in the following screen.

Packsts

* Shour |All Channels || == FEER

.M2 Sample Number Time

HIPI-DSI Pack

Extracted Image

HSal.reImagel ansel

3520 105.337652 ms PP5 Z24h RGE §:
3521 105.350452 ms H 3ync Start |
3522 105.396904 ms PP5 Z24h RGE §:
3523 105, 409736 ns H 3ync Start |
3524 105.456158 us PP5 Z24h RGE §:
3525 105, 465992 ns H 3ync Start |
3526 105.515414 ms PP5 Z24h RGE §:
3527 105, 5258245 ms H 3ync Start |

e 5525 .574664 ms |
4|

Detzils | Header | Fayload | Lanes | Traffic Overview ' Image View

Datz Range

Eeginning OF Data j to: IEndOfData j Find | Show Image.. Export list to CSV ..

Sample Number I Time I Module I

0 264 ns DSl-101

518 15.529312 ms Dsl-101

1038 31.059424 ms DSI-101

15857 46.589024 ms DSI-101

2076 £2.118620 ms DSI-101

2555 77645220 ms Dsl-101

3114 83177822 ms DSI-101

In the Extracted Image dialog box, you can use the [ - ” 3 H ) ” - ] buttons to construct
and display an image from the first, next, previous or last Start of Image Frame locations

currently listed in the Image View tab.

The Extracted Image dialog box also provides you four background patterns |:| B
for the displayed image.

Saving the Extracted Image

Once the extracted image is displayed in the Extracted Image dialog box, the following two options
are available for saving this image:

Save Binary - This button is displayed only if the extracted image is in a RAW format. Using this

button, you can save the image’s pixel bytes in a binary (.bin) file. This allows you to save the raw
image payload data that was originally captured by the U4421A module. This raw image payload
data excludes any modifications that are made as a result of the color information calculation and
decoding the image.

Save Image - This button is available for all image formats. It allows you to save the decoded image
as a .bmp file. For an image with a RAW format, this button allows you to save the modified image
that resulted from the color information calculations and decoding.
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Changing the Decoding Options for the Extracted Image

By default, an image is decoded and displayed in the Extracted Image dialog box as per the image
decoding options set in the Payload tab. If required, you can change the decoding options for the
displayed image to redisplay it as per the changed decoding options.

To change the decoding options of an exiracted image

1

Click the Change the decoding options EI button displayed in the Extracted Image dialog box.
The Raw Image Decode Settings dialog box is displayed.

Change the decoding options as needed. To know more, refer to the topic “Changing Decode
Settings for RAW Image Payload Data" on page 71.

Extracting a Compressed Image

NOTE

Sore

76

For extracting a compressed image, perform the following steps:

1

To view the list of options for compression, right click a Start of Frame location.

-

Details | Header | Payload | Lanes | Traffic Overview " Image View | Compare 1 |

Data Range
[Begi.nningOfDaha - ] to: [End Of Data - ] Find - Show Image...

Frame Number  Sample Number Time Module

0-0 o 2580 us DsI-102

0-1 o 8.262346 ms DsI-102

0-2 1] 16.563774 ms DSI-102
Go to start of frame
Show image...
Go to PPS

Configure Custom PPS...
Compression Settings 3

Export Linked PP5...

' Use linked PPS

Use custom PPS

Compression options are displayed only for DSI packet formats. For packet formats other than
DS, only Go to start of frame and Show image... options are displayed in the right-click menu.

To locate the start of the frame for the particular image and view the frame details in the
Packets section, click Go to start of frame.

To locate the picture parameter set (PPS) for the particular image in the Packets section, click Go
to PPS.

The Use linked PPS option is selected by default when the image is compressed and its PPS is
linked and available in the captured data. You may choose to select/deselect this option for a
compressed image. Selecting this option ensures that the linked PPS is used while extracting the
compressed image.

If you do not want to use the linked PPS or the PPS is not available, you can customize the PPS
values as per your requirements. To do this, click the Configure Custom PPS option.

The DSI Image Compression Settings application is displayed.
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H DSl Image Compression Settings

Compression Settings
[C] Muxing Mode On

PPS

Convert RGB

[T ICH Enable

Enable 422

Block Prediction Enable VBR Enable

PPSId Bits Per Component Compression Bits Per Pixel rate | 128

Picture Width 100 |w|a|  Picture Height 100 [v| A

Slice Width Slice Height 100 Slices Per line 1 Horizontal slices 1

Line Buffer Depth (bits) 9 EB Chunk Size 100 |w[|  Initial Xmit Delay s12 Initial Dec Delay 307 EB

Initial Scale Value

Scale Increment Interval

Scale Decrement Interval

1A

Initial Offset 6144 EB Final Offset Flatness Min QP 3 Flatness Max QP 12 EB
First Line Bpg Offset 1 EB NFL Bpg Offset Slice Bpg Offset 1234 %A

RC Parameters

Maodel Size Edge Factor Quant Incr Limit 0 11 Quant Incr Limit 1 11 ﬂ
Target Offset Hi 3 H Target Offset Lo

Buffer Thresh 14284256 70,84,08105,112,119,121,123, 125,126 14 values range (0-255)

Range Min QP 001133,333.3555713 15 values range (0-31)

Range Max QP 15 values range (0-31)

Range Bpg Offset 200,-2-4,-6-8-8-8-10,-10-12-12-12,-12 15 values range ((-32)-31)

| ExportPs | [ importprs | | ok |[ canca |

Click OK to save the settings specified for custom PPS and return to Protocol Viewer window.

5 Select the Use custom PPS option to ensure that the custom PPS values specified by you are used
for the extraction of the compressed image.

6 To view the image, click Show image...
The details of the image for DSI packet formats are displayed in the Image Format field.
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B8 Bdracted Image [0-1]

1Y Save Image

/B, This image has the following problems:

Some packets are shorter than the calculated image width

Decompressed Image Details

—
2 Bdracted Image [0-2]

5l save Image

/b, This image has the following problems:

Some image data may be missing.

Compressed Image Details

Exporting the list of “Start of Frames” locations to a CSV File

You can also export the list of Start of Frames locations to a CSV file by clicking the Export list to CSV
button. On clicking this button, a CSV file is generated. The list of “start of frames” displayed for the
specified range of captured data is exported to this CSV file. The timestamps of the start of frames
list exported to this CSV file are absolute regardless of the time stetting (Absolute or Relative to
previous frame) that you have selected in the Image View tab.

The following screen displays a sample CSV file with the exported start of frames list.

| Show|CS2 w | Show:| All Channels - || =E
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If you want to export the protocol data displayed in the upper pane of the Protocol Viewer to a CSV
NOTE file, you can use the Export to CSV toolbar button displayed at the top of Protocol Viewer.

Show[MPDS| v| | Show|ll Charnels | + || = = [3E]&] ) = [B) j

- “Packets

The output CSV file has data matching the fields and their sequencing currently displayed in the
upper pane of the Protocol Viewer.

Sample Number Time

0s
102.688 us
154.154 us
205.610 us
257.066 us
262.581 us
308.533 us

L= R B R e R
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MIPI-DSI Packet DataID VCI
V Sync Start (HS) 1

H Sync Start (HS) 21

H Sync Start (HS) 21

H Sync Start (HS) 21

H Sync Start (HS) 21

PPS 24b RGB 8:8:8 (HS] 3E

H Sync Start (HS) 21

[ == R == Y T o e e |

Data Type Word Count Shortl

3E

1

21

21

21

21
18A2

21
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Viewing D-PHY Packet Errors

Packets with errors are displayed in red in the upper pane of the Protocol Viewer. Moving the mouse
pointer to the errored packet displays a tooltip with information about the error found in the packet.

The following screen displays a V Sync Start (HS) packet with a Bad Header ECC error.

Il Channels Protocol: MIPI DS

]
Packet Type: Sync Event, W Sync Start (HS)

= Packet Start Time: 11.828573000 mz
Packet End Time: 11.858578000 mz

Sample Numbher Time ol

Packet Errors:

Field

|I}e5{:ri ption

[F=ader 20C = incarrect

(=)
or
in
[

oool

304 11. 356715 n= E0Tp (H3) [I}5] 0 [I}5] ao
305 11. 353714 ms FP3 lob ¥ChCr 4:2:.. ZC 0 ac nool
306 11. 859790 n= PPS Z4h RGE S:8:8. 3E 0 3E nons
307 11. 861454 ns CM Off [(H3I) 0z 0 0z ao
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Comparing and Debugging D-PHY Packets

You can perform D-PHY packet comparisons using the Compare tab in the lower pane of the Protocol
Viewer window to debug D-PHY packets.

If the Compare tab is not visible, you can click the Open New Compare Window

NOTE = toolbar button from the Protocol Viewer toolbar. You can also use this
toolbar button to display multiple Compare tab pages for comparing multiple
D-PHY packets simultaneously.

By default, the Compare window is displayed as a tab page in the lower pane. However, for ease in
comparing packets, you can display this window as a Dockable or Floating window by right-clicking
the Compare tab name and selecting Dockable or Floating from the right-click menu.

To compare D-PHY packets
1 Select the first packet from the list in the upper pane.

The selected packet’s details are displayed in the Details tab.
2 Click the Compare tab.

3 Click the Set to Selected Component button displayed in the Compare window. Clicking this
button copies the details of the selected packet to the compare buffer in the Compare window.
4 From the list in the upper pane, select the other packet with which you want to compare the
previously selected packet (from step 1).
The details of the second packet are displayed in the Details tab and the differences between the
first and second packet are highlighted in the Compare tab.

In the following screen, two Packet Pixel Stream, 24-bit RGB packets have been compared using a
docked Compare window. Notice that the differences between the two packets are highlighted in
yellow in the Compare window.

Details | Header | Fayvload | Lanes | Traffic Overvisw | Image View | [ (=01

Show only Favorite Fields v | [Favorites..| Packed Poel Stream, 24 | Show all Fields | [Favorites...] | Packed Pixel

Generated Fields
= MIPI-DSI
[=I-Physical Layer
=+ Data ID = 3E Hex

Generated Fields
= MIPI-D51
[=F Physical Layer
=} Data ID = 3E Hex

Wl =0 Hex WOl =0Hex
[=-Data Type = 3E Hex =l Data Type = 3E Hex
Bits[5-4] = 3 Hex Bits[5-4] = 3 Hex
Bits[3-0] = E Hex Bits[3-0] = E Hex
= Word Count = 0480 Hex [=-Waord Count = 0480 Hex
L58 = 80 Hex LS8 = 80 Hex
MSE =04 Hex MSE = 04 Hex
ECC =16 [(GO0OD) ECC =16 (G000)
Address Address

Payload = BYAS BFE2 A48A AS9D 8344 987E

Fayload = 9388 748A 8268 8278 6170 7730 7a...
CheckSum = 4082 (GOOD)

Chackium = D442 (GOOD)
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Viewing Packet and Raw Signal Data using the Waveform Viewer

82

The information about the Waveform Viewer in this topic is specific to viewing and analyzing
D-PHY data. To get general information about the Waveform Viewer, its display, or how to
use it, refer to the following topics in the Logic and Protocol Analyzer Online Help.

- Reference > Windows > Waveform Display Window
- Analyzing the Captured Data > Analyzing Waveform Data

You can view the captured D-PHY data (both packet data as well as raw signal data) as a digital
waveform in the Waveform Viewer. The captured bus/signal data is displayed in a time based

waveform as transmitted on the link. The Waveform view is useful in situations where you want to get
an overview of the D-PHY link transitions.

Components of the Waveform Display

A waveform display primarily has the following components.
The first row in the waveform area is the captured D-PHY packet name across the timeline.
The second row in the waveform area is the timeline for the captured data.

The list in the left pane are the probed D-PHY signal names and their individual channel names
for which data is displayed in the waveform area.

The captured signal data values for the listed D-PHY signals are displayed from the third row
onwards in the waveform area.

For any D-PHY link, the signals for which data is displayed are:
- CLK pand nsignals
LP p and n for each data lane used.

HS for each data lane used. The HS signal is further expandable to display the signal data
across individual channels.

If needed, you can hide a specific signal’s data from the waveform display by right-clicking on the
signal name on the left and selecting Delete Row.

In the following screen, the waveform data is displayed for D-PHY signals of a x1 link.
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10 i Deley [ 12760540 [8) (1 J[ 1) (T J=2R) (1)
11
B . Simple 1176 us 1.186 us 1.196 us 1.206 us 1.216 us 1.226 us 1.236 us 1.24E us 1.256 us 1.2
u=SSignal

il-102:MIPI-DSI Packet
i-102:Time
i-102-R:CLK_p
i-102-R:CLKE_n

i-102-R:D0_LP_p

i-102-R:D0_LP_n

25-102-R:00_HS[0]
25-102-R:D0_HS[1]
25-102-R:D0_HS[2]
25-102-R:0D0_HS[3]
25-102-R:00_HS[4]
25-102-R:0D0_HS[4]
25-102-R:D0_HS[E]

25-102-R:00_HS[T]

Trigger L T T T T T T T O T T T T T N T T Y (N Y SR O AN T SO T B T S|
e Event, H S

You can correlate the data displayed in the waveform with the relevant packet(s) in the Protocol
Viewer. The following screen displays the correlated packet and its data across lanes for the signal
data highlighted in the above screen.
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Packets
M2 : Sample Mumber Time MIPI-D'STI Packet Data ID
|E 1.187 us H Syne End (HE) 3l |
7 1.232 us PF3 1l6b YCbhCr 4:Z:.. 2C
g 1.306 us PR3 1leb ¥ChCr 4:Z2:.. 2C
a 1.455 us FF3 1l6b BGE 5:6:5. OE
10 1.615 us PF3 12b YCbCr 4:Z:.. 3D
11 1.700 us PP5 24b BGE 5:8:8. 3E
1|

Details | Header | Fayload  Lanes | Traffic Overview | Image View | Compare 1

biZ | Time Dsk-102
{ Symbol Time } | Sample Mumber | Lane
1,187 us [ EX ]
1,197 us i oa
1.207 us B 0a
1,217 us i 01
1.232us 7 2C
1.242 us 1 01
1,252 us 7 0a
1.262 us 1 0c

Changing Base Unit of Signal Data Values

By default, the data in the waveform area is displayed in Hexadecimal notation. If required, you can
change the base unit for display of the signal data in the waveform area. To do this, right-click the
bus/signal names displayed in the left pane, select Base from the right-click menu, and then select
the required base unit you want to use for display.

The following screen displays the captured data values in Hex. To change the base unit to Binary, the
right-click menu is displayed.
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Simple 1176 us 1.186 us 1.196 us 1.206 us 1.216 us 1.226 us

Trigger

BusiSignal

D31 02:MIP-DS] Packet
DS-102:Tirme
DS-102-RCLE_p
DS-102-RCLE_n

D3S-102-F:00_LF_p

DSk102-R:D0_LP_n

B DE-102-R:0D0_HS Unda
Insert Row Befare...
Insert Fow After...

DS-102-R:0D0_HS[1] Insert Separatar

Delete Row

I

DS1-102-R:0D0_HS[0]

DSk 02-R:00_HS[2]

Collapse

DS-102-R:D0_HS[3]

DS-102-R:D0_HS[4]

Binary
DSk 02-F:D0_HS[5]
| Cickal
DSl-102-F:00_HS[6] Lverlay. . Decirnal
Signed Decimal
DSH0Z-RDO_HST] oo Ascii
0000001
DS-102-R:D0_HS WALl Find... symbol
Find BusjSignal...

Wiew fs Chart, .,

Display 3

On selecting Binary as the Base unit, the display is changed to binary data values.

()]
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Bus=/Signal

Simple 1476 us 186 us 1196 us 1.206 us 1.216 us 1.226 us
Trigier R T T T S TSN (Y S Y (NN Y TN (NN S NN (NN SRR TN NN SN SO NN

86

DS-102:MIPI-DSI Packet
DS-102:Tirme
DS-102-R:GLK_p
DSl102-R:CLK_n
DS-102-R:D0_LP_p

DS-102-R:00_LP _n

B~ DS-102-R:0D0_HS

DEl-102-R:D0_HS[0]
DS-102-R:D0_HS[1]
DSl-102-R:D0_HS[2]
DSl102-R:D0_HS[3]
DSl-102-R:D0_HS[4]

DS-102-R:D0_HS[5]

DS-102-R:D0_HE[E]
DSI-102-R:D0_HS[T]

D5-102-R:.00_HS_WALID

Svnec Event, H Sync En dl (HS)

1168 us
| I

|III
A Qoo oo
FARY

‘00111001 % 0011 0001 %,

1
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Viewing Raw Signal Data in the Listing Window

The information about the Listing window in this topic is specific to viewing and analyzing
D-PHY signal data. To get general information about the Listing window, its display, or how
to use it, refer to the following topics in the Logic and Protocol Analyzer Online Help.

- Reference > Windows > Listing Display Window
- Analyzing the Captured Data > Analyzing Listing Data

The Listing view is useful in situations where you want to view the acquired raw signal data (without
packet recovery attempts during acquisition). The view provides you an actual representation of the
physical signal activity on the D-PHY link.

Data in the Listing window is displayed only if you configured the U4421A module to capture
the raw signal level data by selecting the Enable Raw Data Capture checkbox. in the Analyzer
Setup tab.

Raw data displays all captured data including oversampled LP data and synchronously sampled HS
data. HS data is also deserialized and displayed as bytes. This type of data can be useful for
understanding re-ordered or inverted lanes, or other physical problems that prevent protocol
framing and decode.

Primarily, a Listing view displays:
The signals for which the data is applicable as columns.

The sample number provided to each of the acquired raw data sample
The start time for the transmission of each sample.

The following screen displays the captured raw signal data for a x1 link.
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sample Mumber CLK. p CLK n DO LP p| DO LP n| DO HS DO HS WALID Tirne

[

aog
B3
a1
aog

ns
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Filtering Packet Data Displayed in Viewers

You can filter the displayed data in viewers to display only those packets that are of significance to
you for analysis or debug.

Filtering changes only the display of data in the viewers and not the captured data. Once filtered, you
can refilter the data display at any time by applying new filter settings.

You use the Filter/Colorize tool to filter data displayed in viewers. To access this tool, click Tools > New
Filter/Colorize from the menubar in the Logic and Protocol Analyzer GUI. On clicking this menu option,
the Filter/Colorize dialog box is displayed. You can click the Help button displayed in this dialog box to
get more details about the Filter/Colorize tool.

In the following screen, the filtering condition is adjusted to display only V Sync Start (HS) packets.

*“Filter/Colorize-1

E] Show ||| when

(¥] | Packet v| | D3I-102:MIPI-DSI Packet | |= |»| [ s¥nc Event, ¥ Sync start (HS)... |

Options... ] [Stu:ure Favarite 3] [Recall Favorite 3] [ oK, ] [ Cancel ] [ Help

The following screen displays the filtered D-PHY data on the basis of the type of packet. Only the V
Sync Start (HS) packets are displayed after filtering.
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Packets
SJample Number Tine HMIPI-D3TI Packet Data ID VCI Data Type

g [0 0 = ¥ Sync Start (H3) 01 0 0l
5l 17.041709 ms ¥V 3ync Jtart (H3) 01 0 o1
103G 34, 0833392 ms ¥V 3ync Jtart (H3) 01 0 o1
1554 51. 125090 ns W 5ync Start (H5) 01 0 o1
2072 5. 166755 ns ¥V 3ync Jtart (H3) 01 0 o1
25580 85, 208471 ms ¥ 3ync Start (H3) 01 0 01
3103 102,250177.. W 3ync Start (H3) 01 0 o1
J0E6 119.,2916875.. W 3ync Jtart (H3) 01 0 o1
4144 136,333569.. W 5ync Start (H3) 01 0 o1
466 2 153.3752a6d.. W 3ync Jtart (H3) 01 0 o1
3130 170,416953.. W 3ync Jtart (H3) 01 0 o1
5695 187.458656.. W 5ync Start (H5) 01 0 o1
G2l 204, 500353, W 3ync Jtart (H3) 01 0 o1
6734 221.542045.. W 3ync Start (H3) 01 0 01
T252 238.583748.. W 3ync Start (H3) 01 0 o1
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7 Using COM Commands for the U4421A Module

Overview

Besides using the U4421A’s GUI components, you can also use the COM interface to configure,
control, and use U4421A. The COM interface allows you to write programs to automate D-PHY
testing using the U4421A module.

This chapter describes the COM commands in the context of the following broad areas of their usage
for D-PHY testing.

Establish a connection with the U4421A module.

Configure stimulus settings for the U4421A module (when used as an exerciser).

Start and stop the transmission of stimulus from the U4427A module.

Change stimulus settings such as lane skew and signal levels for the U4421A module while the
module is sending stimulus.

Insert packet(s) dynamically into an ongoing stimulus transmission from the U4421A module.
Capture D-PHY data.

The topics that follow describe how to use COM commands to perform the above-mentioned tasks.

NOTE Extended help for using COM commands is available in the Logic and Protocol

Analyzer online help, including the complete COM Commands Quick Reference
as well as a general overview of COM Automation for all Logic and Protocol
Analysis systems.

COM Commands Quick Reference

The following table lists the COM commands available for the U4421A module.

Usage area Method/Property name Description

For providing stimulus LoadExerciserParameters (see page 98) Loads the stimulus related settings for the U4421A module to the
Setup dialog box of the U4421A module in the Logic and Protocol
Analyzer GUI.

ApplyToHardware (see page 102) Applies the stimulus related settings loaded in the Setup dialog box
to the U4421A module hardware.

StartExerciser (see page 103) Starts the transmission of D-PHY stimulus from the U4421A
module to a D-PHY DUT.

StopExerciser (see page 104) Stops the transmission of D-PHY stimulus from the U4421A
module to a D-PHY DUT.

ExecuteCommand (see page 105) Loads the specified stimulus settings to the Setup dialog box of the
U4421A module in the Logic and Protocol Analyzer GUL. In
addition, the command also immediately applies these settings to
the U4421A module hardware even when the module is in the
Running state.

The command is useful for changing stimulus settings of the
U4421A module at runtime and for inserting packets dynamically.
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Usage area

For capturing D-PHY data

For obtaining XML format of a
command

Using COM Commands for the U4421A Module 7
Method/Property name Description
RecallTriggerByFile (see page 109) Loads a previously saved trigger specification file for setting up the
trigger for the U4421A module.
Run (see page 110) Starts capturing D-PHY data as per the configured data capture
settings.
Stop (see page 111) Stops the U4421A module from capturing D-PHY data.
GetXmlFormat (see page 112) Returns the XML command format for the given command name.
93
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7 Using COM Commands for the U4421A Module

Before you Start

To use the COM interface, you need to ensure that the following software components of the U4421A
module are installed:

Keysight Logic and Protocol Analyzer software - You need this software component for capturing as well
as generating D-PHY data.

Keysight Logic Analyzer COM Server - This is typically installed at:
C:\Program Files\Keysight Technologies\Logic Analyzer\LA COM Automation\agClientSvr.dll
While using this COM Server, ensure that:

- The COM server connects to a local instance of the Keysight Logic and Protocol Analyzer
application. If the Logic and Protocol Analyzer application is not started, the COM server’s
Connect command starts it.
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Establishing Connection with the U44271A Module

Connection For Sending Stimulus to DUT

To control the transmission flow and alter stimulus settings for the U4421A module using COM, the
client application can use the IExerciser interface pointer. This pointer can be obtained from the
IModules interface after establishing a connection as shown in the example below.

Once the connection is established, you use the obtained pointer to call the specific stimulus related
COM commands.

The following code snippet provides an example of how to establish a connection with the U4427A
module for sending stimulus.

// create the Connect object

AgtLA: :IConnectPtr pConnect =
AgtLA: :IConnectPtr( uuidof (AgtLA: :Connect)) ;

// Using the Connect object, obtain the IInstrument interface

AgtLA: :IInstrumentPtr pInst =
pConnect->GetInstrument (hostName) ;

// Using the IInstrument interface, obtain the IModules
interface

AgtLA: :IModulesPtr modules = pInst->GetModules () ;

// Loop through all the modules in the instrument looking for
those which present the IExerciser interface.

for (long i=0; i<modules->GetCount (); i++)
{
// Using the IModules interface, obtain an IModule
interface.

AgtLA: :IModulePtr module = modules->GetItem( variant t(i));

// Check if this module supports the IExerciser interface by
// type-casting the module pointer.

AgtLA::IExerciserPtr exerciser =
modules->GetItem( variant t(i));

If (exerciser != NULL)

{

// The type-cast worked !

// This module is a U4421A Mipi/DPhy Exerciser/Analyzer
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else

// This module does not support the IExerciser interface

Connection For Capturing D-PHY Data

To control the D-PHY data capture using COM, the client application can use the
ISerialModule interface pointer. This pointer can be obtained from the IModules interface
after establishing a connection as shown in the example below.

Once the connection is established, you use the obtained pointer to call the specific capture related
COM commands.

The following code snippet provides an example of how to establish a connection with the U4421A
module for capturing D-PHY data.

// create the Connect object

AgtLA: :IConnectPtr pConnect =
AgtLA::IConnectPtr(_ uuidof (AgtLA::Connect)) ;

// Using the Connect object, obtain the IInstrument interface

AgtLA::IInstrumentPtr pInst =
pConnect->GetInstrument (hostName) ;

// Using the IInstrument interface, obtain the IModules
interface

AgtLA: :IModulesPtr modules = pInst->GetModules() ;

// Loop through all the modules in the instrument looking for
those which present the ISerialModule interface.

for (long i=0; i<modules->GetCount(); i++)
{
// Using the IModules interface, obtain an IModule
interface.

AgtLA: :IModulePtr module = modules->GetItem(_ variant t(i));

// Check if this module supports the ISerialModule interface
by
// type-casting the module pointer.

AgtLA::ISerialModulePtr capture =
modules->GetItem(_ variant t(i));
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If (capture != NULL)

{

// The type-cast worked !

// This module is a U4421A Mipi/DPhy Analyzer

else

// This module does not support the ISerialModule
interface

}
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Configuring D-PHY Stimulus Settings

Check that you have installed Keysight Logic and Protocol Analyzer software
version 5.50.00 or higher to use the COM commands described in this topic.

You use the LoadExerciserParameters and ApplyToHardware commands to configure
the stimulus related settings for the U4421A module.

LoadExerciserParameters

Ensure that the U4421A module is in a Stop state before you call
LoadExerciserParameters.

Syntax

HRESULT LoadExerciserParameters ([in] BSTR bstrCommandXml, [out] BSTR*
bstrOutInfo, [out, retval] VARIANT BOOL* Success);

Usage Example

exerciser->LoadExerciserParameters (bstrCommandXml,bstrOutInfo) ;

where:
exerciser evaluates to an obtained IExerciser interface pointer (see page 95)
bstrCommandXml evaluates to the input command string containing the stimulus elements
that you want to change. The format of the supported commands is given in the table below.

bstroutInfo evaluatesto an output string that may return some useful information. In case of
MipiDphyExeTimingParameters input command, it returns final calculated values that are going to be

programmed.

Description

Loads the exerciser related settings for the U4421A module as per the values that you specify for the
parameters of this command. The specified values are loaded to the Setup dialog box of the U4421A
module in the Logic and Protocol Analyzer GUI. After the execution of this command, the set values

are displayed in the Setup dialog box.
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Parameter Description

An XML format input string used for configuring the stimulus settings of the U4421A module.
At a time, the string can contain one of the following XML commands. The outer most element represents the command name.

BSTR
bstrCommandXml

bstrOutInfo

The XML format for each command is given below.

Note: The elements are displayed with their start and end tags and a default value. To see a list of valid range of values for

each of these elements, refer Table 6 on page 101.
<MipiDphyExeTimingParameters>
<HS-EXIT-NS>100</HS-EXIT-NS>
<HS-TRAIL-NS>60</HS-TRAIL-NS>
<CLK-PRE-UI>32</CLK-PRE-UI>
<CLK-POST-NS>60</CLK-POST-NS>
<CLK-POST-UI>52</CLK-POST-UI>
<HS-ZERO-UI>88</HS-ZERO-UI>
<HS-ZERO-NS»>2</HS-ZERO-NS>
<HS-PREP-UI>4</HS-PREP-UI>
<HS-PREP-NS>40</HS-PREP-NS>
<CLK-PREP-NS>38</CLK-PREP-NS>
<CLK-TRAIL-NS>60</CLK-TRAIL-NS>
<CLK-ZERO-NS>205</CLK-ZERO-NS>
<LPX-NS>50</LPX-NS>
<TA-GET-NS>250</TA-GET-NS>
<TA-GO-NS>200</TA-GO-NS>
<INIT-NS>100000</INIT-NS>
<WAKEUP-NS>1000000</WAKEUP-NS>
</MipiDphyExeTimingParameters>
<MipiDphyExeOutputs>
<SlewRate>SlewRate_Fast</SlewRate>
<TargetVDD>1000</TargetVDD>

<IgnoreTargetVDDSafteyCheck>False</IgnoreTargetVDDSafteyCheck>

<SMAOutputs>SMAOutputs_Off</SMAQutputs>

</MipiDphyExeOutputs>
<MipiDphyExeBitRate>
<InputClockType>Internal</InputClockType>

<InternalClockValue>Internal_750</InternalClockValue>

<ExternalClockValue>0</ExternalClockValue>
</MipiDphyExeBitRate>
<MipiDphyLaneSkew>
<SkewValueLane0>0</SkewValueLane0>
<SkewValuelLane1>0</SkewValueLanel>
<SkewValuelLane2>0</SkewValueLane2>
<SkewValuelLane3>0</SkewValueLane3>

<SkewInsertionPoint>AnyStopState </SkewInsertionPoint>

</MipiDphyLaneSkew>
<MipiDphySignalLevels>
<LPVHigh>1200</LPVHigh>
<LPVLow>0</LPVLow>
<HSVod»>200</HSVod>
<HSCommonMode>200</HSCommonMode>

<TargetTerminationType > DynamicDifferential1000hms</TargetTerminationType>

</MipiDphySignalLevels>

An output string that can return one of the following:

= the final calculated values for the exerciser related settings of the U4421A module. These values are returned only when
the input command is <MipiDphyExeTimingParameters>. These values are also displayed in the relevant tabs of the Setup
dialog box of the U4421A module in the Logic and Protocol Analyzer GUI.

= an empty string or a string containing some error information (in case of an error) for all other input commands.
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In a call, you can pass one of the above-mentioned XML commands in the XML input
string. Within the passed command, all or some of the above-mentioned tags may be
contained.

Whether you specify a selected few or all tags, ensure that the order in which these are
specified is the same as the order in which these are listed above.

For tags for which you have not specified any value, the value already set in the GUI is
used.

To get a description of what a tag represents, refer to its relevant GUI field description
in this guide.
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Valid values for XML elements of bstrCommandXml String
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XML Element Valid Values/Range

Note: If you pass an out of range value for an XML element, the lowest or highest value from the data range
supported by that element is finally loaded. For example, if the valid data range is 40-85 and you passed 35 as the
value, then the finally loaded value for the element will be 40.

<HS-EXIT-NS>
<HS-TRAIL-NS>
<CLK-PRE-UI>
<CLK-POST-NS>
<CLK-POST-UI>
<HS-ZERO-UI>
<HS-ZERO-NS>
<HS-PREP-UI>
<HS-PREP-NS>
<CLK-PREP-NS>
<CLK-TRAIL-NS>
<CLK-ZERO-NS>
<LPX-NS>
<TA-GET-NS>
<TA-GO-NS>
<INIT-NS>
<WAKEUP-NS>

<SlewRate>

<TargetVDD>

<IgnoreTargetVDDSafteyCheck>

<SMAOutputs>

<InputClockType>

<InternalClockValue>

<ExternalClockValue>

>=50

32-88
0-1000
0-1000

10

0-1000
0-1000
0-2000
10-1000
55-600
10-1000
10-1000
10-1000
10-1000
100-5200000
100-5200000

SlewRate_Fast
SlewRate_Medium
SlewRate_Slow
SlewRate_Slowest

800-3300

True
False

SMAOutputs_Off
SMAOQutputs_On

Internal
External

Internal_750
Internal_1500

75-1500
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XML Element Valid Values/Range

<SkewValuelLane0> For Internal Clock Source set at 750 Mbps:
<SkewValueLane1> -667 to 667

<SkewValuelane2> For Internal Clock Source set at 1500 Mbps:
<SkewValueLane3> -33310 333

For External Clock Source:
Changes as per the input clock frequency

<SkewInsertionPoint> AnyStopState
InsertBitSet
<LPVHigh> 500-1800
<LPVLow> -100to 100
<HSVod> 60-320
<HSCommonMode> x-380 (the starting range varies depending on the values

specified for LPVLow and HSVod)

<TargetTerminationType> DynamicDifferential1000hms
StaticDifferential1000hms
OpenCircuitNoTerminations

Return Value

A Boolean indicating whether or not the command was successful.

ApplyToHardware

Syntax

HRESULT ApplyToHardware ([in, defaultvalue("")] BSTR bstrOption, [out,
retval] VARIANT BOOL* Success) ;

Usage Example

exerciser->ApplyToHardware ("") ;

where exerciser evaluates to an obtained IExerciser interface pointer (see page 95)
Description

Applies the stimulus related settings loaded in the Setup dialog box of the Logic and Protocol
Analyzer GUI to the U4421A module hardware.

_ The XML format input string bst rOption is reserved for future use. This
NOTE input string is not currently used for the U4421A module and should be

specified as an empty string.

Return Values

A Boolean indicating whether or not the command was successful.
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Starting the Stimulus Transmission

You use the StartExerciser command to start the stimulus transmission from the U4421A
module.

StartExerciser

Syntax

HRESULT StartExerciser ([in, defaultvalue("")] BSTR bstrOptionsXML, [out,
retval] VARIANT BOOL* Success) ;

Usage Example
exerciser->StartExerciser ("") ;

where exerciser evaluates to an obtained IExerciser interface pointer (see page 95)

Description

Starts the transmission of the sequence of stimulus currently loaded in the Exerciser Data tab of the
Setup dialog box in the Logic and Protocol Analyzer GUI.

You can use a Logic Analyzer configuration file to load a previous saved stimulus data in the Logic
and Protocol Analyzer GUI. You can use the Open command of the IInstrument interface to open
a configuration file. Refer to the COM Commands help in the Logic and Protocol Analyzer online help
to know more about this command.

The XML format input string bst rOptionsXml is reserved for future use to
contain any XML elements for stimulus start options. This input string is not
currently used for the U4421A module and should be specified as an empty
string.

The StartExerciser command starts the transmission as per the stimulus
data loaded in the Logic and Protocol Analyzer GUI.

Return Value

A Boolean indicating whether or not the command was successful.
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Stopping the Stimulus Transmission

You use the StopExerciser command to stop the stimulus transmission from the U4421A
module.

StopExerciser

Syntax

HRESULT StopExerciser([in] BSTR bstrOptionsXml, [out, retval] VARIANT_BOOL* Success);
Usage Example

exerciser->StopExerciser ("") ;

where exerciser evaluates to an obtained IExerciser interface pointer (see page 95)
Description

Stops the transmission of stimulus from the U4421A module to DUT.

The XML format input string bst rOptionsXml is reserved for future use to
contain any XML elements for stimulus stop options. This input string is not
currently used for the U4421A module and should be specified as an empty
string.

Return Value

A Boolean indicating whether or not the command was successful.
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Changing U4421A Stimulus Related Settings at Runtime

You can use the COM interface to change a few selected stimulus settings of the U4421A module
while the module is in the Running state and transmitting stimulus.

You can change the Lane Skew Control settings at runtime using the ExecuteCommand command.

ExecuteCommand

Syntax

HRESULT ExecuteCommand([in] BSTR bstrCommandXml, [out] BSTR* bstrOutinfo, [out, retval]
VARIANT_BOOL* Success);

Usage Example
exerciser->ExecuteCommand (bstrCommandXml, bstrOutinfo) ;

where:
exerciser evaluates to an obtained IExerciser interface pointer (see page 95)
bstrCommandXml evaluates to an input string with XML format described in the table below.
bstroutInfo evaluatesto an output string described in the table below.

Description

Loads the stimulus settings that you specified as parameters of this command to the Setup dialog
box of the U4421A module in the Logic and Protocol Analyzer GUI. In addition, the command also
immediately applies these settings to the U4421A module hardware. The settings are applied to the
module hardware even when the module is in the Running state.

The command is useful for changing stimulus settings of the U4421A module at runtime as well as
for inserting packets dynamically into an ongoing transmission sequence.

Parameter Description

BSTR An XML format input string used for changing the stimulus settings of the U4421A module at runtime. The string can contain
the following XML command. The outer most element represents the command name.

The XML format for the command is given below.

Note: The elements are displayed with their start and end tags and a sample value. To see a list of valid range of values for
each of these elements, refer Table 7 on page 106.

bstrCommandXml

<MipiDphyLaneSkew>
<SkewValueLane0>0</SkewValueLane0>
<SkewValuelLane1>0</SkewValueLanel>
<SkewValueLane2>0</SkewValueLane2>
<SkewValueLane3>0</SkewValueLane3>
<SkewInsertionPoint>AnyStopState </SkewInsertionPoint>
</MipiDphyLaneSkew>

bstrOoutInfo An output string returning any useful information on command execution.
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_ Within the passed XML command, all or some of the above-mentioned tags may be
NOTE included.

Whether you specify a selected few or all tags, ensure that the order in which these are
specified is the same as the order in which these are listed above.

For tags for which you have not specified any value, the value already set in the GUI is

used.
To get a description of what a tag represents, refer to its relevant GUI field description
in this guide.
Table 7 Valid values for XML elements of bstrCommandXml String
XML Element Valid Values/Range
<SkewValueLane0> For Internal Clock Source set at 750 Mbps:
<SkewValuelane1> -667 to 667
<SkewValuelane2> For Internal Clock Source set at 1500 Mbps:
<SkewValueLane3> -333t0 333
For External Clock Source:
Changes as per the input clock frequency
<SkewlInsertionPoint> AnyStopState

InsertBitSet

Return Value

A Boolean indicating whether or not the command was successful.
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Inserting Packets Dynamically in an Ongoing Stimulus Sequence

You can use the ExecuteCommand command to insert and send packet(s) dynamically as stimulus
to DUT during an ongoing stimulus traffic flow.

When you send a packet as stimulus at runtime, the U4421A module halts the sequence of the main
stimulus flow, sends that packet and then resumes the main stimulus flow from the point at which it
was halted.

You can insert single or multiple packets dynamically. In case of multiple packets, these packets are
sent one after the other in a sequence and then the main stimulus flow is resumed.

Before Executing the Command

Create a CSV file with packet(s) that you want to send dynamically. Make sure that the CSV file
size does not exceed 32 KB otherwise the command returns an error.

Define insertion point(s) - You can either insert packets at any stop state or at the insertion points
that you defined in the main stimulus CSV file. To define an insertion point in the main data CSV
file, you need to set the Special field of the desired packet to “1” in the main data CSV file. The
Insert bit is then set to 1 at this point and this packet becomes the insertion point for the packets
to be inserted dynamically.

The following screen displays a main stimulus CSV file in ASCII format with a dynamic packet
insertion point defined. Notice that the Special field of one of the packets is set to 1.

// Example Main Packets in a CSI-2/DSI ASCII Format File
nsTime, LPS, Escape, ULPC, Special, Clock, Data
// Start Image Frame 1

00000514e0, 0, 0O, G, 1
goooo0514e0, 1, 0, 0, O, 1, 01, 00, 00, 00
goooloz2s20, 1, 0, O, O, 1, 21, 00, 00, 0O
goools43g0, 1, 0, 0, 0, 1, 21, 00, 00, OO0
gooozos840, 1, 0, 0, 0O, 1, 21, 00, 00, 0O
//—— Frame = 1, Line = 1

gooozs7300, 1, 0, O, 0O, 1, 21, 00, 00, 0O

goooz2ezelo, 1, 0, 0, 0, 1, 3e, l1le, 00, 00, f££, 00, 00, f£f, 00, 00, ££, 00, 00, £
//—— Frame = 1, Line = 2

gooo3oge7e0, 1, 0, 0, 0, 1, 21, 00, 00, 00

gooo0314270, 1, 0, 0, 0, 1, 3e, 1e, 00, 00, 00, f££f, 00, 00, f££, 00, 00, ££f, 00, O
//—— Frame = 1, Line = 3

000030220, 1, 0, 0, 0O, 1, 21, 00, 00, 00

gooo3es730, 1, 0, 0, 0, 1, 3e, 1le, 00, 00, 00, 00, f£f£, 00, 00, ££f, 00, 00, £f£, 0

Based on whether you want to insert packets at “Any Stop State” or at an insertion point with
“InsertBitSet”, you specify the value of the <PacketInsertionPoints> tag (see details below).

ExecuteCommand

Syntax

HRESULT ExecuteCommand([in] BSTR bstrCommandXml, [out] BSTR* bstrOutinfo, [out, retval]
VARIANT _BOOL* Success);
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Usage Example

exerciser->ExecuteCommand (bstrCommandXml, bstrOutinfo) ;

where:
exerciser evaluates to an obtained IExerciser interface pointer (see page 95)
bstrCommandXml evaluates to an input string with XML format as described in the table below.
bstroutInfo evaluatesto an output string as described in the table below.

Description

Inserts packet(s) dynamically into an ongoing transmission sequence. Packets are added from a CSV
format file that you specify as the input parameter.

Parameter Description

BSTR An XML format input string used for inserting packets into an ongoing stimulus transmission.
The string can contain the following XML command. The outer most element represents the command name.

bstrCommandXml The XML format for the command is given below.
Note: The elements are displayed with their start and end tags, sample value as well as the other permitted value.
<MipiDphyDnyamicPktInsert>
<CsvPath>D:\\Images\\Packts.csv</CsvPath>
<PacketInsertionPoint>AnyStopState</PacketinsertionPoint> //Other option for this element is InsertBitSet.
<MipiDphyDnyamicPktInsert>
bstrOoutInfo An output string returning any useful information on command execution.
NOTE For the above-mentioned XML input string, it is mandatory to specify the <CsvPath>
tag value. Also, ensure that the order in which the tags are specified is the same as the

order in which these are listed above.

For the tag for which you have not specified any value, the value already set in the GUI
is used.

To get a description of what a tag represents, refer to its relevant GUI field description
in this guide.

Return Value

A Boolean indicating whether or not the command was successful.
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Loading Trigger Specifications for Data Capture

You use the RecallTriggerByFile command to load the trigger settings for the U4421A module
from a previously saved trigger specification file.

RecallTriggerByFile

Syntax
HRESULT RecallTriggerByFile([in] BSTR TriggerFileName, [out, retval]
VARIANT BOOL* Success) ;

Usage Example
capture->RecallTriggerByFile (TriggerFileName) ;

where capture evaluates to an obtained ISerialModule interface pointer (see page 96) and
TriggerFileName evaluate to an input string that contains the name and location of the trigger
specification file.

Description

Loads a previously saved trigger file to set up the trigger for the U4421A module. The command
accepts the name and complete path of the trigger file as the input parameter.

Parameter Description

TriggerFileName A string representing the name and location of the XML-format trigger specification file.
Example -
TriggerFileName = “C:\\Trigger Specs\\SampleTrigger.trg”

Return Value

A Boolean indicating whether or not the command was successful.
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Starting the Data Capture

110

You use the Run command to start the data capture using the U4421A module. Data is captured as
per the currently configured data capture settings in the Setup dialog box of the U4421A module in
the Logic and Protocol Analyzer GUI.

Prior to executing this command, you can load a Logic Analyzer configuration file with the required
data capture settings that the Run command can use. You can use the Open command of the
IInstrument interface to load a configuration file. Refer to the COM Commands help in the Logic
and Protocol Analyzer online help to know more about this command.

Run

Syntax
HRESULT Run([in, defaultvalue(0)] VARIANT BOOL Repetitive) ;
Usage Example

pInst->Run (FALSE) ;

where pInst evaluates to an obtained IInstrument interface pointer (see page 96)
Description

Starts running the U4421A module to capture D-PHY data. The Run command takes a Boolean as
input parameter. The value “True” indicates that the module will run continuously until the Stop
command is called where as the value “False” indicates that the module will run only once.

Return Value

A Boolean indicating whether or not the command was successful.
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Stopping the Data Capture

You use the Stop command to stop the data capture using the U4421A module.

Stop

Syntax

HRESULT Stop () ;

Usage Example

pInst->Stop () ;

where pInst evaluates to an obtained IInstrument interface pointer (see page 96)
Description

Stops all the currently running data acquisition modules.
Return Value

A Boolean indicating whether or not the command was successful.
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Getting XML Format of a COM Command

You can use the GetXmlFormat command to obtain the XML format for the command/tag that you
specified as parameter with this command.

GetXmlFormat

Syntax

HRESULT GetXmlFormat([in] BSTR bstrCommandName, [out] BSTR* bstrXmlFormat, [out, retval]
VARIANT _BOOL* Success);

Usage Example
GetXmlFormat(bstrCommandName, bstrXmlFormat);
where:
bstrCommandName evaluates to an input string described in the table below.

bstrXmlFormat evaluates to an output string described in the table below.

Description

Returns the XML format of the command that you specified as parameter of this command.

bstrCommandName An input string representing the top-level tag name of a XML command for which the XML
format is required.
For instance, you can pass MipiDphyExeTimingParameters toget
the XML format of the MipiDphyExeTimingParameters usedin
LoadExerciserParameters.

bstrXmlFormat An output string that returns the XML format of the command that you specified in the input
parameter.

Return Value

A Boolean indicating whether or not the command was successful.
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